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IMPORTANT! Before using this product, read and understand the information in the
“Safety” appendix in this document.

Product description

Related products

The CLA Identifiler Plus and Identifiler”™ Direct PCR Amplification Kits are 5-dye,
16-locus short tandem repeat (STR) analysis kits with 1 sex-discriminating marker.
Both kits amplify the same loci as the AmpF2STR™ Identifiler™ PCR Amplification Kit.

The CLA Identifiler™ Plus kit uses genomic DNA.

The CLA Identifiler” Direct kit uses cells spotted on a NUCLEIC-CARD™ matrix. This
kit does not require DNA extraction or purification.

Features of the kits include:
* Compatible with SeqStudio™, 3500/3500xL, and 3730/3730x| genetic analyzers.

¢ Compatible with all cell line databasing loci standards and global databasing loci
standards.

Cell line authentication using short tandem repeat (STR) analysis kits can be used
both for human sample authentication (HSA) and mixed sample analysis (MSA).

* In HSA, the STR kits can be used to verify the DNA profile of the sample or to
perform a quality check.

* In MSA, the STR kits can be used to deconvolute the presence of multiple
contributors in a sample (chimerism) by identifying more than one DNA genotype
in the sample.

The CLA GlobalFiler™ PCR Ampilification Kit is a 6-dye, 24-locus short tandem repeat
(STR) analysis kit with 3 sex-discriminating markers. The kit uses genomic DNA. It
provides reduced amplification time and increased discrimination power compared to
the AmpF2STR™ Identifiler™ Plus and AmpF2STR™ Identifiler” Direct PCR
Amplification Kits.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 7



Product description

Dyes used in the kits

Chapter 1 Product information

Dye Color Label
6-FAM™ Blue Samples, allelic ladders, and controls
vic™ Green
NED™ Yellow
PET" Red
Liz™ Orange GeneScan™ 600 LIZ" Size Standard v2.0

Loci amplified by the kits

Locus Chromosome . ; . DNA Control
designation location Alleles included in Allelic Ladder Dye label 9947A
D8S1179 8 8,910, 11,12, 13, 14, 15,16, 17, 18, 19 6-FAM™ 13,13
D21S11 21q11.2-g21 |24, 24.2, 25, 26, 27, 28, 28.2, 29, 29.2, 30, 30.2, 30, 30
31, 31.2, 32, 32.2, 33, 33.2, 34, 34.2, 35, 35.2,
36, 37, 38
D7S820 7q11.21-22 16,7,8,9,10, 11,12, 13, 14, 15 10, 11
CSF1PO 5033.3-34 6,7,8,9,10,11,12,13, 14,15 10,12
D3S1358 3p 12,13, 14,15, 16, 17,18, 19 vic™ 14,15
THO1 11p15.5 4,5,6,7,8,9,9.3,10,11,13.3 8,9.3
D13S317 139g22-31 8,9,10, 11,12, 13,14, 15 11, 11
D16S539 16924.qter |5, 8,9, 10, 11,12,13, 14, 15 11,12
D2S1338 2935-37.1 15,16, 17, 18, 19, 20, 21, 22, 23, 24, 25, 26, 27, 19, 23
28
D19S433 19912-13.1 |9,10,11,12,12.2,13,13.2, 14, 14.2, 15, 15.2, NED™ 14,15
16, 16.2,17,17.2
vWA 12pi12-pter |[11,12,13, 14, 15,16, 17, 18, 19, 20, 21, 22, 23, 17,18
24
TPOX 2p23-2per 5,6,7,8,9,10,11,12,13 8,8
D18S51 18921.3 7,9,10,10.2, 11,12, 183, 13.2, 14, 14.2, 15, 16, 15,19
17,18, 19, 20, 21, 22, 23, 24, 25, 26, 27
Amelogenin | X:p22.1-22.3 |X,Y PET" X
Y: p11.2

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide




Chapter 1 Product information — E&%#
Product description

Locus Chromosome . . . DNA Control
designation location Alleles included in Allelic Ladder Dye label 9947A
D5S818 5021-31 7,8,9,10,11,12,13, 14, 15, 16 PET" 11, 11
FGA 4928 17,18, 19, 20, 21, 22, 23, 24, 25, 26, 26.2, 27, 23,24
28, 29, 30, 30.2, 31.2, 32.2, 33.2, 42.2, 43.2,
44.2,45.2,46.2, 47.2, 48.2,50.2, 51.2

Standards and controls that are required

The CLA Identifiler” Plus and Identifiler™ Direct PCR Amplification Kits require the
following panel of standards needed for PCR amplification, PCR product sizing, and
genotyping:
* DNA Control 9947A—A positive control for evaluating the efficiency of the
amplification step and STR genotyping of the kit allelic ladder. DNA Control
9947A is included in the kit. See “DNA Control 9947A profile” on page 10.

* GeneScan™ 600 LIZ" Size Standard v2.0—Used for obtaining sizing results.
This standard, which has been evaluated as an internal size standard, yields
precise sizing results for PCR products. See “GeneScan” 600 LIZ" Size
Standard v2.0” on page 11.

¢ Allelic ladder—Developed for accurate characterization of the alleles amplified
in each kit. The allelic ladder is included in each kit and allows automatic
genotyping of most of the reported alleles for the loci in the kit. See “Loci
amplified by the kits” on page 8 and “Allelic ladder profile” on page 12.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide
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DNA Control 9947A profile
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Figure 1 Control DNA 9947A (1 ng) amplified with the Identifiler” Plus kit and analyzed on an Applied

Biosystems™ 3130x/ Genetic Analyzer
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Figure 2 GeneMapper  Software plot of the GeneScan" 600 LIZ" Size Standard v2.0
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Allelic ladder profile

ladder “i “i “i ‘ | |E [~ Mark Sample For Deletion
[D8sT1T9 |EE ] [D7Ss20 ] [CSFPO ]
130 70 k) 250 280 330 370
B00
400
ol

Izdder CRCECEE [ (@ I Mark Sample for Deletion
0351358 ] L | D13sAT | 0165538 | 251338 |
f 130 170 210 230 280 330 70
B00
" 11 J l 1 ll 1 11 1 l l
= m — T
ozl =lells] sl e ele] SR REE 2] pe] felslnelfs] 7 o e s e N s = 5[ [ =1 e B e
lzdder ‘li ‘li ‘ﬁ ‘ | |E [~ Mark Sample for Deletion
JUEEELE] | WA | [TPOX | [DT0551 ]
f 130 70 210 250 200 230 70
F00
Ank A &
| 61| 0 Y A (3| [y 23] ] fes] e ar]fis]faofao] [21f22 ]z El E“Mmhipz El BEE | Y | {3 Y (| {50 | 5 B3 | 2 |
Bzl
2] 3] 143
1zdder ‘li ‘li ‘Ii ‘ | |E [~ Mark Sampls for Delstion
[AMEL] [D55ET [FGR ]
130 T Fl 2350 200 330 70

00

Figure 3 GeneMapper " Software plot of the Identifiler” Allelic Ladder
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Contents and storage— ldentifiler™ Plus kit

The Identifiler™ Plus kit contains sufficient quantities of the reagents for 200 reactions

at 25 pyL/ampilification.
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IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer mix, amplified DNA, allelic ladder, and size standard from light

when not in use.

IMPORTANT! Do not refreeze kit components after thawing.

200 reaction

DNA 9947A

female 9947A genomic DNA
from cell line in 0.05%
sodium azide and buffer.[]

See “DNA Control 9947A
profile” on page 10 for
information.

Contents Description (Cat. No. 4427368) Storage
Identifiler™ Plus Master | Contains enzyme, salts, 2x1.0mL —25°C to —15°C on receipt.
Mix dNTPs, car.rler prgteln, and 2°C to 8°C after first use for up to
0.04% sodium azide. o
6 months or up to the expiration
date stated on the kit (whichever
comes first).
Identifiler™ Plus Primer | Contains forward and 1x1.0mL -25°C to —15°C on receipt.
Mix reverse primers to amplify 2°C to 8°C after first use for up to
human DNA targets. I
6 months or up to the expiration
date stated on the kit (whichever
comes first).
Store protected from light.
Identifiler™ Plus Allelic Contains amplified alleles. 1 x 50.0 L —25°C to —15°C on receipt.
Ladder See “Allelic ladder profile” 2°C to 8°C after first use up to the
on page 12 for information. expiration date stated on the kit.
Store protected from light.
AmpF2STR™ Control Contains 0.1 ng/pL human 1 x 30.0 uL —-25°C to —15°C on receipt.

2°C to 8°C after first use up to the
expiration date stated on the kit.

' DNA Control 9947A is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation of the
capability of the kit reagents to generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you
quantify aliquots of Control 9947A, the concentration may differ from the labeled concentration.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide
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Chapter 1 Product information
Required materials not supplied

Contents and storage—CLA Identifiler™ Direct kit

The Identifiler™ Direct kit contains sufficient quantities for 200 reactions at

25 pl/amplification.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer mix, amplified DNA, allelic ladder, and size standard from light

when not in use.

IMPORTANT! Do not refreeze kit components after thawing.

200 reaction (Cat. No.

DNA 9947A

female 9947A genomic DNA
from cell line in 0.05%
sodium azide and bufferl'l

See “DNA Control 9947A
profile” on page 10 for
information.

Contents Description 4427368) Storage
Identifiler™ Direct Master | Contains enzyme, salts, 2x1.25mL —25°C to —15°C on receipt.
Mix dNTPs, car.rler pr(?teln, and 2°C to 8°C after first use for up to
0.04% sodium azide. o
6 months or up to the expiration
date stated on the kit (whichever
comes first).
Identifiler™ Direct Primer | Contains forward and 2 x1.25mL -25°C to —-15°C on receipt.
Mix reverse primers to amplify 2°C to 8°C after first use for up to
human DNA targets. .
6 months or up to the expiration
date stated on the kit (whichever
comes first).
Store protected from light.
Identifiler™ Direct Allelic | Contains amplified alleles. 1 x 50.0 L —25°C to —15°C on receipt.
Ladder See “Allelic ladder profile” 2°C to 8°C after first use up to the
on page 12 for information. expiration date stated on the kit.
Store protected from light.
AmpF2STR™ Control Contains 0.1 ng/pL human 1 x 50.0 uL —-25°C to —15°C on receipt.

2°C to 8°C after first use up to the
expiration date stated on the kit.

' DNA Control 9947A is included at a concentration that is appropriate for use as an amplification control (that is, to provide confirmation of the
capability of the kit reagents to generate a profile of expected genotype). It is not designed for use as a DNA quantification control. If you
quantify aliquots of Control 9947A, the concentration may differ from the labeled concentration.

Required materials not supplied

14

See Appendix A, “Materials required but not supplied”.
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Chapter 1 Product information  E#82
Identifying the presence of contaminating cells in a culture

Identifying the presence of contaminating cells in a culture

One objective of cell line authentication is to determine whether a cell line is
contaminated with unrelated cells. Because contaminating cells are likely to have a
different STR profile than the parent cell line, use of CLA STR kits is a useful tool to
flag the presence of contamination.

In a mixture of cell lines, the final DNA profile reflects the genomic makeup of all cells
present. Therefore, data must be examined carefully.
* One peak at a locus could represent:
— Homozygous parent cell DNA
— Homozygous parent cell and homozygous contaminating cell DNA

— Homozygous parent cell DNA and a deletion at the locus for contaminating
cell DNA
¢ Two peaks at a locus could represent:
— Heterozygous parent cell DNA

— Both cell types homozygous for different loci

— Both cell types heterozygous for the same loci

The interpretation of aberrant peaks at a single locus can be challenging and
ambiguous. However, with the analysis of 16 loci and 1 sex-discriminating marker in
the CLA Identifiler” Plus and Identifiler™ Direct PCR Amplification Kits, it can be
possible to identify distinct peaks that clearly point to the presence of a
contaminating cell line, even if the genomic makeup of the contaminating cell line is
not fully discernible.

Instrument and software compatibility

Instrument ibl -

type Compatible mode

Thermal * ProFlex" 96-well PCR System (Cat. No. 4484075)
cyclers * ProFlex” 2 x 96-well PCR System (Cat. No. 4484076)

The kit is not optimized for use with:
ProFlex™ 2 x Flat PCR System (Cat. No. 4484078)
ProFlex™ 2 x 384-well PCR System (Cat. No. 4484077)

e Veriti" Fast 96-Well Thermal Cycler (Cat. No. 4375305)
e GeneAmp" PCR System 9700 with the aluminium 96-well block (Cat. No. 4314879)

ProFlex™ 3 x 32-Well PCR System (Cat. No. 4484073)

Veriti™ 96-Well Thermal Cycler (Cat. No. 4479071)

GeneAmp™ PCR System 9700, 96-Well Silver (Cat. No. N8050001)
GeneAmp™ PCR System 9700, 96-Well Gold-Plated (Cat. No. 4314878)

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 15



82982 Chapter 1 Product information

a Workflow
Instrument c ibl |
type ompatible mode!
Genetic * SeqStudio™ Genetic Analyzer vi1.1.4 or later
analyzers * 3500/3500xL Genetic Analyzer with any of the following:
- 3500 Data Collection v3.3 Software (Windows™ 10 operating system)
- 3500 Data Collection v3.1 Software (Windows™ 7 operating system)
e 3730/3730xL DNA Analyzer (48-capillary recommended) with any of the following:
- Data Collection v5 Software (Windows™ 10 operating system)
- Data Collection v4 Software (Windows™ 7 operating system)
Note: The 48-capillary array is recommended for the 3730xI instrument. The close proximity
of capillaries in the 96-capillary array can introduce cross-talk between capillaries and
interfere with data interpretation.
¢ 3130/3130xL DNA Analyzer with Data Collection Software v4
Analysis * Microsatellite Analysis Software (accessible from apps.thermofisher.com)
software * GeneMapper" Software v6 Software (Windows™ 10 operating system)
* GeneMapper" Software v5 Software (Windows™ 7 operating system)

Workflow

Perform PCR

If you are analyzing a cell suspension, see: If you are spotting a cell suspension on a

Chapter 2, “Perform PCR: CLA Identifiler™ Plus kit” NUCLEIC-CARD " matrix, see:
Chapter 3, “Perform PCR: CLA Identifiler" Direct
kit”

v

Perform electrophoresis, see:
“Electrophoresis software setup: SeqStudio”” on page 29
“Electrophoresis software setup: 3500/3500xL” on page 29
“Electrophoresis software setup: 3730/3730x! instruments” on page 30

“Electrophoresis software setup: 3130/3130x! instruments” on page 30
v
“Prepare samples for electrophoresis” on page 33
v
Analyze data, see:
Chapter 5, “Analyze data with Microsatellite Analysis Software”

Chapter 6, “Analyze data with GeneMapper™ Software”

16 CLA Identifiler™ Plus and Identifiler™ Direct PCR Ampilification Kits User Guide
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Guidelines for cell line preparation, extraction, and purification

Follow your standard laboratory operating protocol and consider the following
guidelines:

The required DNA input amount is 1 ng of genomic DNA extracted from cells.

If a cell line is to be used for research and the identity is unknown, expand the
cell line before use.

Follow cell culture best practices.
Handle cell lines under quarantine conditions if the cell line identity is unknown.

One T-25 flask (for attached cells) or a 125 mL Erlenmeyer (for suspension)
provides enough material for DNA extraction.

Obtain cells at an early passage.

Continue growing cells. Consider quarantine until the STR identification is
available. After obtaining the STR identification, proceed with preparing freeze
stocks or continued use of the cells for additional experiments.

Clean the work surface area thoroughly.

Prepare samples one at a time.

Clearly label samples with cell line information.

Extract, purify, and quantify the DNA, see www.thermofisher.com/gdnaprep.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 17
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Effect of DNA quantity on results

The required DNA input amount is 1.0 ng for 29-cycle PCR or 500 pg for 30-cycle
PCR.

If too much DNA is added to the PCR reaction, the increased amount of PCR product
that is generated can result in:

* Fluorescence intensity that exceeds the linear dynamic range for detection by

the instrument (“off-scale” data).
Off-scale data is a problem because:

— Quantification (peak height and area) for off-scale peaks is not accurate. For
example, an allele peak that is off-scale can cause the corresponding stutter

peak to appear higher in relative intensity, thus increasing the calculated
percent stutter.

Multicomponent analysis of off-scale data is not accurate. This inaccuracy
results in poor spectral separation (“pull-up”).

* Incomplete +A nucleotide addition.
To address these issues, reamplify the sample using less DNA.

If too little DNA is added to the PCR reaction, the total number of allele copies added

to the PCR is extremely low and unbalanced amplification of the alleles can occur
because of stochastic fluctuation.

Before you begin

Prepare low-TE buffer

For optimal results, we recommend using low-TE buffer for sample preparation.
Prepare it as described in this procedure or buy it from Teknova (Cat. No. T0223).

1. Mix together:
¢ 10 mL of 1 M Tris-HCI, pH 8.0
* 0.2mL of 0.5 M EDTA, pH 8.0
* 990 mL glass-distilled or deionized water

Note: Adjust the volumes accordingly for specific needs.
2. Aliquot, then autoclave the solutions.

3. Store the aliquots at room temperature.

18 CLA Identifiler™ Plus and Identifiler™ Direct PCR Ampilification Kits User Guide
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Thaw reagents (before first use of the kit)

Thaw the master mix and primer mix.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2°C to 8°C and do not require subsequent thawing. Do not
refreeze the reagents.

Prepare the amplification kit reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

1. Vortex the master mix and primer mix for 3 seconds. Before opening the tubes
or bottles, remove droplets from the caps by centrifuging the tubes briefly or
tapping the bottles on the bench.

2. Pipette the required volumes of components into an appropriately sized, clear
(non-colored), polypropylene tube:

Reaction component Volume per reaction
Master mix 10.0 pL
Primer mix 5.0 uL

Note: The allelic ladder is not a sample. Do not include it in PCR.
Note: Include volume for additional reactions to provide excess volume for the
loss that occurs during reagent transfers.

3. Vortex the reaction mixture for 3 seconds, then centrifuge briefly.

4. Dispense 15 pL of reaction mixture into each reaction well of a MicroAmp "
Optical 96-Well Reaction Plate or each MicroAmp™ tube.

5. Adjust the sample input amount and volume if needed:

¢ |f total sample input amount is >1.0 ng for 28 cycles or >500 pg for
29 cycles, dilute with low-TE buffer to achieve a 10-pL input volume.

¢ If total input volume is <10 pL, adjust the volume with low-TE buffer to
achieve a 10-pL input volume.
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Number of PCR cycles to use

6. Prepare samples as shown in the following table, then add them to the

appropriate well or tube (final reaction volume is 25 pL).

Sample

28-cycle protocol

29-cycle protocol

Negative control

10 pL of low-TE buffer

10 pL of low-TE buffer

Test sample

10 uL of DNA
(1.0 ng input amount)

10 pL of DNA
(0.5 ng input amount)

Positive control

10 pL of control DNA
(0.1 ng/pL)

10 pL of control DNA
(0.1 ng/pL)

7. Seal the MicroAmp™ Optical 96-Well Reaction Plate with MicroAmp™ Clear
Adhesive Film or MicroAmp™ Optical Adhesive Film, or cap the tubes.

8. Amplify the samples.

IMPORTANT! See “Instrument and software compatibility” on page 15 for a list
of optimized thermal cyclers.

Number of PCR cycles to use

All kits are optimized for a specific number of amplification cycles to deliver well-
balanced and high quality results. However, increases in the number of low-level DNA
samples being submitted for analysis have prompted many laboratories to evaluate a
higher number of amplification cycles to improve the sensitivity of the assay. Before
increasing the cycle number, perform a comprehensive validation study to establish
new performance criteria for the higher cycle number.
Higher cycle numbers can cause the following to occur:

¢ Exaggerated stochastic effects resulting from low DNA input amounts

* Greater difference between the presence and absence of an allele

* Greater heterozygote peak imbalance

* Possible differences in expected stutter position and percentage

¢ Possible increase in artifacts and/or background in the profile to accompany the

increase in sample allele signal

The Identifiler™ Plus kit offers two PCR-cycle-number options:

* Standard 28-PCR-cycle protocol—Provides high sensitivity to consistently
generate full STR profiles with 125 pg of DNA input. Use with the optimum
1.0 ng DNA input amount in a maximum input volume of 10 pL.

* 29-PCR-cycle protocol—Adds the extra sensitivity when amplifying
<125 pg DNA input. Recommended for use when the total DNA input amount is
<0.5 ng.
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IMPORTANT! This kit is optimized for use with the validated thermal cyclers that are
listed in “Instrument and software compatibility” on page 15.

1.

Program the thermal cycling conditions.

IMPORTANT! Set the thermal cycler you are using as indicated: ProFlex" PCR
System: 9700 Simulation ramping mode (see the ProFlex" PCR System Kit
Validation User Bulletin (Pub. No. 100031595); Veriti" Thermal Cycler: 9600
emulation mode (see Veriti" 96-Well Thermal Cycler AmpFESTR™ Kit Validation
User Bulletin (Pub. No. 4440754).; GeneAmp " PCR System 9700 with 96-well
silver or gold-plated silver block: Max ramping mode.

Initial Cycle (28 or 29 cycles)!! :
. . Final .
incubation . Final hold
Denature | Anneal/Extend | €Xxtension
step
HOLD CYCLE HOLD HOLD
95°C, 94°C, 59°C, 60°C, 4°C,
11 minute 20 seconds 3 minutes 10 minutes | Up to 24 hours!?

[ See “Number of PCR cycles to use” on page 20.
[l The infinity (c0) setting allows an unlimited hold time.

Load the plate into the thermal cycler, close the heated cover, then start the run.

IMPORTANT! If you are using adhesive clear film instead of caps to seal the
plate wells, place a MicroAmp Optical Film Compression Pad

(Cat. No. 4312639) on top of the plate to prevent evaporation during thermal
cycling. The ProFlex " PCR System and the Veriti" Thermal Cycler do not require
a compression pad.

When the run is complete, store the amplified DNA.

If you are storing the DNA... Then place at...
<2 weeks 2°Cto 8°C
>2 weeks -25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.
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Guidelines for cell line preparation, extraction, and purification

22

Follow your standard laboratory operating protocol and consider the following
guidelines:

Prepare the cell line samples with an optimal target cell density of 1 x 10°
cells/mL

- For cell density >1 x 10° cells/ mL, dilute with a volume of phosphate
buffered saline (PBS) that yields a cell density of 1 x 106.

- For cell density <1 x 10° cells/ mL, re-centrifuge, then resuspend in a
volume of PBS that yields a cell density of 1 x 108,

If a cell line is to be used for research and the identity is unknown, expand the
cell line before use.

Follow cell culture best practices.
Handle cell lines under quarantine conditions if the cell line identity is unknown.

One T-25 flask (for attached cells) or a 125 mL Erlenmeyer (for suspension)
provides enough material for spotting on NUCLEIC-CARD™ matrix.

Obtain cells at an early passage.

Continue growing cells. Consider quarantine until the STR identification is
available. After obtaining the STR identification, proceed with preparing freeze
stocks or continued use of the cells for additional experiments.

Clean the work surface area thoroughly.
Prepare samples one at a time.
Clearly label samples with cell line information.
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Prepare the NUCLEIC-CARD™ matrix with sample |

Prepare the NUCLEIC-CARD " matrix with sample

Note: The allelic ladder is not a sample. Do not include it in PCR.

1. Spot 40 pL of the cell suspension in the center of the matrix.

\®
— @

Cell ID

Passage
Date

[—
SLTHTIETITE VI —
@ Matrix

@ 40 pL of the cell suspension spotted in center of matrix

2. Place the spotted card in a laminar flow hood and allow to dry at room
temperature for 24 hours.

3. Obtain the punch: Place the tip of a 1.2 mm puncher in the center of the card,
hold the barrel of the puncher (do not touch the plunger), gently press and twist
1/4-turn, then eject the disc in to the appropriate well on the reaction plate.

Note: Do not add water to the wells on the reaction plate before adding the
discs. If you observe static issues with the paper discs, you can prepare and
dispense the 25-pL reaction mix into the wells of the reaction plate before
adding the punches.
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Cell ID

Passage
Date

 —

QO | 17111 e

@ Obtain the punch from the center of the sample spotted on the matrix

@ Clean the puncher for the next sample by obtaining a punch from a clean area of the
matrix away from the spotted sample

4. Clean the puncher for the next sample by obtaining a punch from a clean area of
the matrix away from the spotted sample. Discard the punch.

5. (Optional) To store the spotted NUCLEIC-CARD™, place it in a paper envelope
with a desiccant packet. Spotted cards can be stored at room temperature for
up to 20 years.

Before you begin

Thaw reagents (before first use of the kit)

Thaw the master mix and primer mix.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

IMPORTANT! Thawing is required only during first use of the kit. After first use,
reagents are stored at 2°C to 8°C and do not require subsequent thawing. Do not
refreeze the reagents.
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Prepare the amplification reactions

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.
Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

If this is the first time you are using the kit, follow the instructions in “Thaw reagents
(before first use of the kit)” on page 19 before proceeding.

1. Add sampiles to the reaction plate:

To these wells ... Add...
Negative control 1.2 mm blank disc
Test samples 1.2 mm sample disc
Positive control 2 pL of Control DNA 9947A
IMPORTANT! Do not add a blank disc to
the positive control well.

Note: The volumes of positive control are suggested amounts and may be
adjusted if peak heights are too high or too low for your optimized cycle number.

2. Vortex the master mix and primer mix for 3 seconds. Before opening the tubes
or bottles, remove droplets from the caps by centrifuging the tubes briefly or
tapping the bottles on the bench.

3. Pipet the required volumes of components into an appropriately sized

polypropylene tube.
Reaction component Volume per reaction
Master mix 12.5 yL
Primer mix 12.5uL

Note: Include volume for additional reactions to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! This kit is optimized for a 25-puL PCR volume to overcome the
PCR inhibition that is expected when amplifying unpurified samples. Using a
lower PCR reaction volume may reduce the ability of the kit chemistry to
generate full STR profiles.

4. Vortex the reaction mix for 3 seconds, then centrifuge briefly.

5. Dispense 25 pL of the reaction mix into each reaction well of a MicroAmp™
Optical 96-Well Reaction Plate.
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® Chapter 3 Perform PCR: CLA Identifiler™ Direct kit

Seal the plate with MicroAmp™ Clear Adhesive Film (Cat. No. 4306311) or
MicroAmp™ Optical Adhesive Film (Cat. No. 4311971).

IMPORTANT! We recommend adhesive film for plate sealing to provide a
consistent seal across all wells and prevent evaporation. Do not use caps, which
may not provide a consistent seal across all wells.

IMPORTANT! If you are using the GeneAmp™ PCR System 9700 with silver or
gold-plated silver block and adhesive clear film instead of caps to seal the plate
wells, place a MicroAmp™ Optical Film Compression Pad (Cat. No. 4312639) on
top of the plate to prevent evaporation during thermal cycling. Other optimized
thermal cyclers do not require a compression pad.

Centrifuge the plate at 3,000 rpm for about 20 seconds in a tabletop centrifuge
with plate holders.

Amplify the samples as described in Chapter 3, “Perform PCR: CLA Identifiler™
Direct kit”.

IMPORTANT! This kit is not optimized for use with the GeneAmp™ PCR
System 9700 with the aluminum 96-well block. Use of this thermal cycling
platform can adversely affect performance of this kit.

IMPORTANT! This kit is optimized for use with the thermal cyclers that are listed in
“Instrument and software compatibility” on page 15.

1.

Program the thermal cycling conditions.

IMPORTANT! Set the thermal cycler you are using as indicated: ProFlex" PCR
System: 9700 Simulation ramping mode (see the ProFlex" PCR System Kit
Validation User Bulletin (Pub. no. 100031595); Veriti" Thermal Cycler: 9600
emulation mode (see Veriti" 96-Well Thermal Cycler AmpFESTR™ Kit Validation
User Bulletin (Cat. No. 4440754).; GeneAmp™ PCR System 9700 with 96-well
silver or gold-plated silver block: Max ramping mode.

Initial 26 cycles Final
incubation . Final hold
step Denature | Anneal Extend extension
HOLD CYCLE HOLD HOLD
95°C, 94°C, 59°C, 72°C, 60°C, 4°C,
11 minutes |20 seconds | 2 minutes 1 minute 25 minutes | Up to 24 hour
sl

' The infinity (c0) setting allows an unlimited hold time.
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Perform PCR 24

2. Load the plate into the thermal cycler, close the heated cover, then start the run.

IMPORTANT! If you are using adhesive clear film instead of caps to seal the
plate wells, place a MicroAmp™ Optical Film Compression Pad

(Cat. No. 4312639) on top of the plate to prevent evaporation during thermal
cycling. The ProFlex™ PCR System and the Veriti" Thermal Cycler do not require

a compression pad.

3. When the run is complete, store the amplified DNA.

If you are storing the DNA...

Then place at...

<2 weeks

2°C to 8°C

>2 weeks

-25°C to -15°C

IMPORTANT! Protect the amplified DNA from light.

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide
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Perform electrophoresis

Allelic ladder requirements for electrophoresis ........................... 28
Materials required for electrophoresis ..., 29
Set up the instrument for electrophoresis (before first use of the kit) ........ 29
Capillary toplate mapping . ... .o v i e 30
Prepare samples for electrophoresis ............. ... i, 33

Allelic ladder requirements for electrophoresis

28

To accurately genotype samples, you must run an allelic ladder with the samples.

Number of allelic . _Onc_a Number of samples per allelic
Instrument injection
ladders to run ladder(s)
equals
SeqgStudio™ |1 per 6 injections 4 samples 23 samples + 1 allelic ladder
3500 1 per 3 injections 8 samples 23 samples + 1 allelic ladder
3500x/ 1 per injection 24 samples 23 samples + 1 allelic ladder
3130 1 per 4 injections 4 samples 15 samples + 1 allelic ladder
3130xI 1 per injection 16 samples 15 samples + 1 allelic ladder
3730l 2 per injection 48 samples 46 samples + 2 allelic ladders

' The 48-capillary array is recommended for the 3730xI instrument. The close proximity of capillaries in the 96-

capillary array can introduce cross-talk between capillaries and interfere with data interpretation.

IMPORTANT! Variation in laboratory temperature can cause changes in fragment
migration speed and sizing variation between runs. Follow the guidelines in the
preceding table, which should account for normal variation in run speed. Perform
internal validation studies to verify the required allelic ladder injection frequency, to
ensure accurate genotyping of all samples in your laboratory environment.

It is critical to genotype using an allelic ladder run under the same conditions as the
samples. Size values obtained for the same sample can differ between instrument
platforms, because of different polymer matrices and electrophoretic conditions.
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Materials required for electrophoresis

Appendix A, “Materials required but not supplied” lists the required materials that are
not supplied with this kit.

IMPORTANT! The fluorescent dyes attached to the primers are light-sensitive.

Protect the primer set, amplified DNA, allelic ladder, and size standard from light
when not in use.

Set up the instrument for electrophoresis (before first use of the kit)

For procedures to set up the instrument, see the user guide for the instrument.

Electrophoresis software setup: SeqStudio™

The following table lists the data collection software and the run modules that you
can use to analyze PCR products generated by this kit. For details on the
procedures, see the documents listed in “Documentation and support” on page 108.

Genetic analyzer

Data Collection

Software Run conditions

SeqStudio™

v1.1.4 or later * Run module: FragAnalysis
* Dye Set G5

Electrophoresis software setup: 3500/3500xL

Genetic . 3500 D.ata .
analyzer Operating system Collection Run conditions
Software
3500 Windows™ 10 v3.3 * Run module: FragmentAnalysis36_POP7 or
FragmentAnalysis50_POP7
3500xL
¢ Dye Set G5

3500 Windows™ 7 v3, v3.1

3500xL

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide 29
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Electrophoresis software setup: 3730/3730xI instruments

Genetic Operating system | 212 Collection E U
analyzer perating sy Software
3730 Windows™ 10 v5 ¢ Run module: GeneMapper_36_POP7_1 or
3730xLI"] GeneMapper_50_POP7_1
* Dye Set G5
3730 Windows™ 7 va
3730xI["

' The 48-capillary array is recommended for the 3730xI instrument. The close proximity of capillaries in the 96-capillary array can introduce cross-

talk between capillaries and interfere with data interpretation.

Electrophoresis software setup: 3130/3130xI instruments

X

Genetic . Data Collection "
analyzer Operating system Software Run modules and conditions
3130 Windows™'7 vd * FragmentAnalysis36_POP7_1 or
FragmentAnalysis50_POP7_1
3130x/

Injection conditions: 3 kV/5 sec (3 kV/10 sec for
L)

Dye Set G5

[ If you observe off-scale peaks, optimize the injection time for your instrument.

Capillary to plate mapping
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Figure 4 SeqStudio capillary-to-plate mapping

Injection 1 (wells A1-D1)
Injection 2 (wells E1-H1)
Injection 3 (wells A2-D2)
Injection 4 (wells E2-H2)
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Figure 5 3500 96-well plate capillary-to-plate mapping (8 capillary)
(O Injection 1 (wells A1-H1)
(O Injection 2 (wells A2-H2)

EOPEEOE®OE
PEEEEOOO
n SICISIGISOIO0
POREEO®EE
PEEE®EOEE
a SIOICIGIOOIO0
BOeE®EOEE®
PEEEEOO®E
m SLCIOISOBIO0)
POPEEO®EE®

PEEEEOO®O
OO O®

@
ol
ol
o

Figure 6 3500xL 96-well plate capillary-to-plate mapping (24 capillary)
(O Injection 1 (wells A1-C12)
(O Injection 2 (wells D1-F12)
(O Injection 3 (wells G1-112)
O Injection 4 (wells J1-L12)
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Figure 7 3730/3730xI capillary-to-plate mapping (48-capillary array)
() Injection 1 (wells A1-H1, A3-H3, A5-H5, A7-H7, A9-H9, A11-H11)
() Injection 2 (wells A2-H2, A4-H4, A6-HB6, A8-H8, A10-H10, A12-H12)
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Figure 8 3130 capillary-to-plate mapping
() Injection 1 (wells A1-D1)
() Injection 2 (wells E1-H1)
(O Injection 3 (wells A2-D2)
() Injection 4 (wells E2-H2)
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Figure 9 3130xlI 96-well plate capillary-to-plate mapping (8 capillary)
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Injection 1 (wells A1-H2)
Injection 2 (wells A3-H4)
Injection 3 (wells A5-H6)
Injection 4 (wells A7-H8)
Injection 3 (wells A9-H10)
Injection 4 (wells A11-H12)

Prepare samples for electrophoresis

Prepare the samples for electrophoresis immediately before loading.

1.

2.

3.

Pipet the required volumes of components into an appropriately sized
polypropylene tube:

Reagent Volume per reaction
GeneScan" 600 LIZ™ Size Standard v2.0 0.5 L
Hi-Di™ Formamide 8.5 uL

Note: Include volume for additional samples to provide excess volume for the
loss that occurs during reagent transfers.

IMPORTANT! The volume of size standard indicated in the table is a suggested
amount. Determine the appropriate amount of size standard based on your
experiments and results.

Vortex the tube, then briefly centrifuge.

Into each well of a MicroAmp™ Optical 96-Well Reaction Plate, add:
® 9 L of the formamide/size standard mixture

* 1 pL of PCR product or allelic ladder
Note: For blank wells, add 10 pL of Hi-Di" Formamide.
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Prepare samples for electrophoresis

4. Seal the reaction plate with film, then briefly vortex and centrifuge the plate to
ensure that the contents of each well are mixed and collected at the bottom.

5. Heat the reaction plate in a thermal cycler at 95°C for 3 minutes.
6. Immediately place the plate on ice for 3 minutes.
7. Remove the film, then seal with the appropriate septa.

8. Place the sample tray on the autosampler, then start the electrophoresis run.
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Analyze data with Microsatellite
Analysis Software

B Overview of Microsatellite Analysis Software ............................ 35
B Allelic ladder requirements for CLA dataanalysis ......................... 36
B Names and versions of settings files used in this section .................. 36
B Access the Microsatellite Analysis Software and import files ............... 36
B Set up the Microsatellite Analysis Software for analysis (before first use

Of the Kit) . ..o 40
B Select settings and analyze samples in the Microsatellite Analysis Software . 49
B Review the analysis summary ............ it 50
B Examine low-quality sizingresults ........ ... .. 51
B Examine low-quality genotypingresults ......... .. ... . i, 56
B Exportthe genotypestable ........ ... .. 60
B \Verify cell line identity using the ATCC database ......................... 61

This chapter contains brief procedures. For more information on using the software,
click @ (Help) in the top right of any Microsatellite Analysis Software screen.

For information on known artifacts in STR kits, see “Application notes” on page 109.

Overview of Microsatellite Analysis Software

Microsatellite Analysis Software is a microsatellite genotyping module available on
the Connect cloud-based platform thermofisher.com/connect.

This software is used to analyze a mixture of DNA fragments, separated by size. The
analysis provides a profile of the separation, precisely calculates the sizes of the
fragments, and determines the microsatellite alleles present in the sample.

The software allows you to view, edit, analyze, print, and export microsatellite marker
data generated using Applied Biosystems™ genetic analyzers.

Note: You may observe minor differences in results if you analyze the same data in
the GeneMapper™ Software.
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Allelic ladder requirements for CLA data analysis

Allelic ladder requirements for CLA data analysis

CLA analysis requires at least one allelic ladder sample per project. Perform the
appropriate internal validation studies before you use multiple allelic ladder
samples in a project.

For multiple allelic ladder samples, the software calculates allelic bin offsets by
using an average of all allelic ladders that use the same panel in a project.

Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type
column in a project. Analysis will fail if the Allelic Ladder Sample Type is not
specified.

Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples to ensure proper allele
calling.

Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can
contain full and/or partial repeat units. An off-ladder allele is an allele that occurs
outside the bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.

Names and versions of settings files used in this section

The names and version numbers of the settings files that are shown in this section
may differ from the names and version numbers that you see when you download or
import files.

Access the Microsatellite Analysis Software and import files

36

Before you begin, save FSA files from an instrument run to your computer, to your
Connect account on thermofisher.com/connect, or to a Dropbox™ account. The
FSA files can be analyzed or unanalyzed.

This section uses example data files collected on the SeqStudio™ Genetic Analyzer.
Example data files may be available for download. For information, see “(If needed)
Download newer versions of settings files” on page 41.

1.

2.

Go to thermofisher.com/connect.

Scroll down to the sign in options, then sign in.

Don’t have an account? m Already have a Connect user ID? Sign in

In the My Apps list at the top right of the screen, click Microsatellite Analysis.
IMPORTANT! Click the text, do not click the icon.
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&3 Upload files Create project (O} Search

My apps View all apps

-

Recommended apps

MSA

[ ]
Mo

Microsatellite Analysis

CE Fragment Eg
More info

If Microsatellite Analysis is not listed under My Apps, scroll down in the All

Apps list.
Dashboard © rbout & Uploadfiles [ Create project Q) Search
Recent files View all my files My apps
W ce ecommended apps
T Microsatellite Analysis
™ CE Fragment Sizing
o Mare info

tecently used Filter by =
™) Peak Scanner
H CE Fragment Sizing
View all my instruments More info

4. In the Open Project dialog box, select or create a project, then click OK.

Open project X

Open an app within an analysis project
Use Existing Project

®] Create New Project

Type a project name

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide
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5. In the top right of the Manage Data Files screen, click Import From, select the
location of the files, then select the FSA data files of interest.

© &v

My Computer
Therma Fisher Cloud

Dropbox

6. In the top left of the Manage Data Files screen, click .

Manage Data Files

Files in the project

Name

A1_A1_Sample_20171103_161303.fsa

B1 B1 Sample 20171103 161304.fsa

The Setup screen is displayed.
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MSA Setup Results

° Set analysis options then analyze 4 samples ¥ Template Manager Actions v

[+

Size Standard View SaveAs  Panel Edit Save A= Analysis Settings View SaveAs | Summary
4 of 4 samples are prepared Reanalyze Samples

GSE00LIZ - - Microsatellite Default - for analysis

8
m Analysis Summary E Sample Table _

Overall Summary

Analysis Results Sizing Genotyping
Analyzed Unanalyzed Reanalyze Total Pass Suspect Low Quality Total Pass Suspect Low Quality Total
0 0 4 4 Y 0 @0 4 ®0 0 @0 0

®

@_

Results by Sample Type

Sample o
S
@
N Q
Sizing Genotyping b
@
e

Pass Suspect Low Quality Total Pass Suspect Low Quality Total

04 0 o0 4 @0 o ®0 0

@ Analysis options for all samples in the project.

@ Analysis Results lists the total number of samples in the project and the number of samples in each analysis status category.
@ Sizing and genotyping results for all samples in the project.

@ Sizing and genotyping results for all samples in the project, organized by sample type.

7. |If this is the first time you are using the software, or if you are unsure if the latest
settings are available in the software, continue to “Set up the Microsatellite
Analysis Software for analysis (before first use of the kit)” on page 40.

If you know that the latest settings are available in the software, skip to
page 49.
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Set up the Microsatellite Analysis Software for analysis (before first use of the kit)

Set up the Microsatellite Analysis Software for analysis (before first

use of the kit)

About importing files into the Microsatellite Analysis Software database

Before you use Microsatellite Analysis Software to analyze CLA data for the first time,
you must import the latest settings files (see “(If needed) Download newer versions of
settings files” on page 41).

IMPORTANT! Settings files are instrument-specific. Ensure that you import files for
the instrument that corresponds to the data you will analyze.

Note: The names and version numbers of the files that are shown in this section may
differ from the file names and version numbers that you see when you download or

import files.
If you need help to determine the correct files to use, contact your local field
applications scientist or technical support.

File

quality flags.

File to import type Description See page
MSA Settings Template IncIuo!es all settings rlequwed for analysis: glze standard, panels
(preferred method) ZIP | and bins, and analysis method. It also retains the plot and table 42
P settings of the project from which it was exported.

Optional individual files to import if you did not import a template (alternative method)

Panel and bins Defines the markers (loci) that are being interrogated, and

(Created with 1P includes bins (location of expected alleles) for each marker. a4
Microsatellite Analysis

Software)

Size Standard XML | Defines the sizes of the fragments present in the size standard. 46
Analysis settings XML Defines the settings for peak detection, allele calling, and peak 47

Workflow: Set up Microsatellite Analysis Software

Before you use Microsatellite Analysis Software to analyze data for the first time, you
must do the following:

40

“Check settings file versions on your computer” on page 41

v

“(If needed) Download newer versions of settings files” on page 41

v

“Import an MSA settings template (preferred method)” on page 42
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Check settings file versions on your computer

1. Access the Microsatellite Analysis Software as described in “Access the
Microsatellite Analysis Software and import files” on page 36.

2. Click £+ next to Size Standard.

° Set analysis options then analyze 5 samples

Size Standard View Save As Panel Edit Save As Analysis Settings View Save As

GS600LIZ - None - Microsatellite Default -

3. Look for settings with a _CLA suffix and check the version of files.

Select your size standard

Size Standard Name

Example_Size 5tandar

4. Check the version of files for Panel and Analysis Settings.

Select your panel Select your analysis setting

Panel Name Settings Name

Exanmle_Pan Example_Analysis Euettin

5. Check for newer versions of the files on the website as described in the next
procedure.

(If needed) Download newer versions of settings files

1. Go to www.thermofisher.com.

2. In the search field, type CLA, then select the kit of interest.

!ll‘alryh?fiihe{ Popular Applications & Techniques Shop All Products  Services  Support

Search All v CLA

Search suggestions
A44560 — CLA IdentiFiler™ Plus PCR Amplification Kit
A44661 — CLA IdentiFiler™ Direct PCR Amplification Kit

Ad4662 — CLA GlobalFiler™ PCR Amplification Kit
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3. Scroll down to the Documents section.

Documents

Product literature

= Application Guide: SeqStudio Genetic Analyzer
J Application Note: Authenticating human cell lines using the Identifiler kits and capillary electrophoresis platforms

. Brochure: DNA fragment Analysis by Capillary Electrophoresis

'@_entifiler Data Analysis File Download CLA \;D

& Matching identities of IPSCs and donors using Identifiler STR. profiling kits
) Technical Note: Confidently identify human samples using theCLA Identifiler and CLA GlobalFiler STR kits

J- White Paper: Matching identities of iPSCs and donors using CLA Identifiler STR profiling kits

4. |If this is the first time you are using the Microsatellite Analysis Software, or if a
newer version of the download file is available, download the new file.

5. Unzip the file.
The ZIP file contains a separate folder for each instrument type. Each instrument
folder contains a folder with Microsatellite Analysis Software settings and
GeneMapper™" Software settings (ignore this folder). The Microsatellite Analysis
Software folder contains:

* MSA_Template_CLA_vX.zip—Contains the settings needed to analyze
data in the Microsatellite Analysis Software. Do not unzip the MSA ZIP file.
The ZIP file is a template that contains size standard, panel and bins and
analysis settings.

* MSA_Analysis_Settings_CLA_vX folder—Optional individual settings that
are also in the template. These files are not needed if you import the
template.

Import an MSA settings template (preferred method)

An MSA settings template ZIP file is created by exporting a template from the
Microsatellite Analysis Software. For information on exporting a template, click @ .

A settings template ZIP file can include all files required for analysis: size standard,
panels and bins, and analysis method. It also retains the plot and table settings of the
project from which it was exported.

If the size standard, panel, and analysis method libraries do not contain CLA settings,
or if you downloaded a new version of the template ZIP file, follow this procedure to
import the template ZIP file into the Microsatellite Analysis Software.
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Note: Alernatively, you can import individual settings. See “Import individual settings
(alternative method)” on page 44.

1. Access the Microsatellite Analysis Software as described in “Access the
Microsatellite Analysis Software and import files” on page 36.

2. At the top right of the screen, click Template Manager.

@ Setup Results

° Set analysis options then analyze 5 samples

¥ Template Manager () Analyze  Actions v

3. In the Template Manager dialog box, click Import.

Template Manager X

Select your template Auto analyze  [#} Export

Template Name Size Standard Modified On  w Delete

= e

4. In the Import Template dialog box, enter a name for the template (include a
"CLA_vX suffix), click My Computer, then click Import.

Import Template X

Name

Comments

Import From

My Computer Thermo Fisher Cloud

Cancel

5. Navigate to, then select the ZIP file for your instrument that you previously
downloaded (see “(If needed) Download newer versions of settings files” on
page 41), then click Open.

The ZIP file is listed in the Template Manager.
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6. Click Apply.
The settings are applied to the project.

° Set analysis options then analyze 5 samples

Size Standard Edit SaveAs Panel Edit SaveAs  Analysis Settings Edit. Save A=
Example Size Standard CLA_vX ¥ Example Panel CLA_vX h Example Analysis Settings CLA vX ~

Import individual settings (alternative method)

44

If you did not import an MSA settings template, or if you want to update specific
settings only, you can import individual settings.

Import an MSA panel (ZIP file created in the Microsatellite Analysis
Software)

Note: This step is not required if you imported an MSA settings template.

A panel ZIP file is created by exporting a panel from the Microsatellite Analysis
Software. For information on exporting a panel, click @.

If your computer already contains the correct size standard and analysis method, and
you only need to import panel and bins, follow this procedure to import the panel and
bins.

1. Access the Microsatellite Analysis Software as described in “Access the
Microsatellite Analysis Software and import files” on page 36.

2. Click &¢ in the Panel pane.
Panel Edit Save As

MNone -

3. Click Import in the Panel Manager.

eate a panel {Jmport Panel]

display rently

els to dis

4. Click Microsatellites in the Import
Panel dialog box.

Import Panel X

GensMapper { Microsatellites

Import panel (marker) and bin file (.zip)

O &

My Computer Thermo Fisher Cloud
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5. Click the import location, then select the panel ZIP file.
6. Click Open, then click Import.

7. Navigate to, then select the ZIP file that you previously downloaded (see “(If
needed) Download newer versions of settings files” on page 41), then click
Open.

8. Enter a panel name, then click Next.

Note: If a character limit warning is displayed, delete all characters starting with
the first parenthesis in the name. For example if the name is
"GF_3500_MSA_Panel_CLA_v1 (GF_3500_v2) Imported", delete "(GF_3500_v2)
Imported".

The Panel Manager displays the panels and associated bins.

Panal Name * Markers + Bins
My - i ‘
D183551 ; a 9 . ST Markars Bin Details Reference Dats
B 0 NN 190 230.321.333 330 M T Acdbeder [ Doiote bt
Moo [+, Min Mo Hogear Sheter
DEEsE] u DE449 G0 4 013
A ]
4 H D317 2 0950
" F
- - o —
D i
.............. i LELRs N LA RNNRRRRNNRRRY ¢ 0 8 —— . . -
I |
S1EEE1 DTSk L §
! 8 8 | SR - = = =
8 ] 5 .
- | | '
‘ | bt | =N e

IMPORTANT! If the left pane does not show gray bins, click Import Bins at the bottom left of the screen, then
import the associated bin file.

9. Click Save, then click Back to Library.

10. Click Apply to select the panel for the project.
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Import a CLA size standard (XML files provided by Thermo Fisher
Scientific)

Note: This step is not required if you imported an MSA settings template.

1. Access the Microsatellite Analysis Software as described in “Access the
Microsatellite Analysis Software and import files” on page 36.

2. Click £+ in the Size Standard pane. @
Size Standard View Save As
3. Click Import in the Size Standard
library. GS600LIZ -

Size Standard X

Select your size standard Auto analyze [ Export "™, Clone
Size Standard Name Description #Peaks  Created On Modified On v Details Delste
a GS1200UZ Factory Provided 68 11-Aug-2008 07:39 ... 2008 07:39 ... View
a Factory Provided 27-Jun-2008 02:03 PM  27-Jun-2008 02:03 PM
a GSB00LIZ Normalization Factory Provided 36 27-Jun-2008 01:59 PM  27-Jun-2008 01:59 PM  View
a . (GS500(-35.-250,-340)ROX Factory Provided 13 11-Jun-2008 08:04 PM  11-Jun-2008 08:04 PM View
a GS500(-35,-250,-340)LIZ Factory Provided 13 17-Apr-2008 05:58 PM  17-Apr-2008 05:59 PM View
a . GS500ROX Factory Provided 16 17-Apr-2008 05:58 PM  17-Apr-2008 05:58 PM View
@ [ cssooesorox Factory Provided 15 17-Apr-2008 05:56 PM  17-Apr-2008 05:56 PM  View
a SNPlex_a8plex_v1 Factory Provided 1 26-Sep-2003 02:16 ...  26-Sep-2003 02:16 ... View -

=
4. In the Import Size Standard dialog

box, click the location of the files,

Import From

then click Import. e N
5. Navigate to and select the size
standard XML file, then click Open. [ carcol |
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6. In the Import Size Standard dialog box, edit the size standard information if
needed, then click Save.

Import Size Standard

Size Standard Name and Dye Caolor
¥ Example_LS_Size Standard_CLA vX
Description (optional)
Local Southern Sizing 80-460

Number of Peaks: 26

60.00, 80.00, 100.00, 114.00, 120.00, 140.00, 160.00, 180.00, 200.00, 214.00,
220.00, 240.00, 250.00, 260.00, 280.00, 300.00, 314.00, 320.00, 340.00, 3560.00,
380.00, 400,00, 414.00, 420.00, 440.00, 460.00

Note: If a character limit warning is displayed, delete all characters starting with
the first parenthesis in the name. For example if the name is
"GF_MSA_SizeStd_CLA_v1 (GF_3500_v2) Imported", delete "(GF_3500_v2)
Imported".

The size standard is added to the Size Standard library.

7. Inthe Size Standard library, click Apply to select the size standard for the
project.

Import a CLA analysis settings (XML file provided by Thermo Fisher
Scientific)

Note: This step is not required if you imported an MSA settings template.

1. Access the Microsatellite Analysis Software as described in “Access the
Microsatellite Analysis Software and import files” on page 36.

2. Click &+ in the Analysis Settings
pane. Analysis Settings View Save As

Microsatellite Default -
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3. Click Import in the Analysis Settings library.

Analysis Settings X

Select your analysis setting Auto analyze  [# Export "™ Clone

Settings Name Created On Modified On  w Details Delete

B Microsatellite Default 26-Apr-2018 06:37 AM  26-Apr-2018 06:37 AM

= =3 e e

4 Inthe Import Anaysis Settings

dialog box, click the location of the o

files, then click Import.
i © @&

My Computer Thermo Fisher Cloud

5. Navigate to and select the analysis
settings XML file for your instrument, e=n
then click Open.

6. Click Save.

Note: If a character limit warning is displayed, delete all characters starting with
the first parenthesis in the name. For example if the name is
"GF_3500_MSA_AM_CLA v1 (GF_3500_v2) Imported", delete "(GF_3500_v2)
Imported".

The analysis settings file is added to the Analysis Settings library.

7. In the Analysis Settings library, click Apply to select the analysis settings for
the project.

Plot and table settings

Plot and table settings are not stored in separate files that you can import and export.
However, the current plot and table settings are retained when you export a template
from the Microsatellite Analysis Software. For information on exporting a template,
click @.
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Select settings and analyze samples in the Microsatellite Analysis
Software
1. If CLA settings are not selected, click £¥ for Size Standard, Panel, and

Analysis Settings, then select the appropriate CLA size standard, CLA panel,
and CLA analysis settings.

14 ] & e
Size Standard Edit Savess Panel  Edit Save As Analysis Settings view Save As

G560-600LIZ - MNone - Microsatellite Default -

IMPORTANT! Analysis settings are instrument-dependant. Size standard may
also be instrument-dependant. Make sure to select an anaysis settings file that
corresponds to the instrument on which the imported data was collected.

2. Click the Sample Table tab.

o)
Size Standard Edit Savess Pa

Example Size Standard_ CLA_ wX ™ |

IEI Analysis Summary | E Sample Table

@ Setup Results

° Set analysis options then analyze 5 samples

!,Temp\ate Manager Reanalyze Actions v

Size Standard Edit SaveAs Panel Edit Savens  Analysis Settings Edit Savens  Summary
0 of 5 samples are prepared for Reanalyze Samples
Example Size Standard CLA_vX ™ Example Panal CLA_vX - Example Analysis Setlings CLA_vX ~ analysis

o Status  SQ GQ..  Sample File Name Sample Name Sample Type Instrument Model  Plate Id Wl Size Standard Panel 0S REF sal
=] ® C1_PosCtrl.fsa 9947A #  Positive Control # SeqStudio-3200 96-Wel col GSE00LIZ
=] [ ] D1_NegCtrl fsa Negative Contral  Negative Control #* 96-Wel Do1 GS600LIZ
L] . B1_Sample_02.fsa M4A4 #  Sample 4 96-Wel BO1 Gs600LIZ
o ® A1_Sample_01fsa Hela # Sample s 96-Wel AQ1 GS600LIZ
L] . E1_Ladderfsa Allelic Ladder #  Allelic Ladder s 96-Wel EO1 GS600LIZ
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Review the analysis summary

5.

In the figure on the previous page, the SQ result for the samples is @ because
the samples are automatically analyzed with the size standard from the data
collection software.

Note: For more information about the columns in the sample table, click @.

If needed, click a Sample Type field, then select the sample type for the sample.
At least 1 allelic ladder sample type is required.

Select the checkboxes for the samples to analyze. You can click the checkbox
in the header to select all samples.

Click Reanalyze Samples.

Analysis Summary ‘ E Sample Table

Status SQ GQ a  Sample Name Sample Type Instrument Model Well  Size Standard Panel 0s

Negative Control #  Negative Control rd Example Size Std Example Panel

Positive Control 4 Example Size Std Example Panel
Example Size Std Example Panel

Example Size Std Example Panel

Allelic Ladder #  Allelic Ladder rd Example Size Std Example Panel

Review the analysis summary

50

1.

Click the Analysis Summary tab.

£
Size Standard Edit Save As P:

Example Size Standard_ CLA_ _vX ~

ﬁ Analysis Summary E Sample Table

Note: For more information about the columns in the sample table, click @.
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Overall Summary

Analysis Results Sizing Genotyping
Analyzed Unanalyzed Reanalyze Total Pass Suspect Low Quality Total Pass Suspect Low Quality Total
5 Q a ] b 0 @0 5 0 Q ®: 5

@ I

Results by Sample Type

Allelic Ladder

@_ Sizing Genotyping

Pass Suspect Low Quality Total Pass Suspect Low Quality Total
1 a @0 1 o 0 [ N 1
Sample
Sizing Genotyping
Pass Suspect Low Quality Total Pass Suspect Low Quality Total
4 [\ ®0 4 0 0 ®: 4

@ Sizing and genotyping results for all samples in the project.
@ Sizing and genotyping results for all samples in the project, organized by sample type.

2. Click the number next to any @, © , or @ indicator to display the results for the
sample or allelic ladder.

Examine low-quality sizing results

Before proceeding, ensure that you have selected the correct size standard and
analysis method (which may be instrument-specific) for the data you are analyzing.

View data collection settings

1. In the Setup screen, open the Sample Details window using one of the
following methods:

* Right-click on the sample file in the Sample Table, then click View Sample
Details.

* Click Actions » View Sample Details.
2. Click Information to review the data collection settings.

3. Click Close.
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Examine EPT and raw data

Review the EPT (ElectroPherogram Telemetry) plot to identify instrument performance
issues that can affect size quality.

Review the raw data to evaluate anomalies, the causes of poor size-calling, and to
determine the start and stop points for analysis. The start point for data analysis
occurs after the primer peak and before the first sizing peak. The stop point for
analysis occurs after the last sizing peak.

1. Open the sample details window using one of the following methods:

* Right-click on the sample file in the Sample Table, then click View Sample
Details.

® (Click Actions » View Sample Details.
2. Click EPT to view the EPT pilot.
3. Click Raw Data to view the raw data plot.

4. Click Close.

Review size matches
1. In the Setup screen, click the Analysis summary tab.

2. In the Sizing analysis results pane, click on the blue number next to © or @ to
review size matches for these samples in the Size Matching tab of the Results
screen.

Genotyping
Pass Suspect Low Quality Total

2 2 [ 5

v

3. Modify the size matches as needed.
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Modify size matches

If the software does not correctly detect size standard peaks, you can modify the size
matches, then apply the modified size standard definition to all selected samples in
the project.

1. Select an option to view the peak assignments for the size standard peaks in the
selected sample:

Option Action

View in Size Matching tab | q, | the Results screen, click the Size Matching

tab.

2. Select a sample from the sampile list to view the
peak assignments in the Sizing Match pane at the
bottom of the screen.

View in Size Match Editor | 4 | the Results screen, click the Sizing tab.

2. Select one or more samples from the sample list.
3. Click Actions » View Size Match Editor.

Sizing Match Size Calling Curve
GS600LIZ an 7% @, e, "m, Override 5Q v In
Size Quality (5Q) = 1.0
36 Size Peak
e Feaks 0 1000 2000 3000 4000 5000 6000 7000 5000 2000 10000
* ) 1 114 -
4000 -
18 160 - 100 1 280, 4
3500-{ 60 i z081¢ | 260
19 i 6
3000+ 140 32 20812 42
s 31% 20 | *6%aq
20 180 2500 T N 4
se0
20004 an sl
21 20 sen)
15004 | z00
22 200 seeT
10004
23 =00
0
24 214 .
Reanalyze all files with this size standard Export size standard (.xml)

2. Examine all size standard peaks to ensure that all peaks are present, peaks are
labeled correctly, and the sizes match the fragment sizes in the size standard
definition file that is used for the sample.
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3. Change size values or delete peaks as needed, then auto-adjust size matches.
This function is useful if the software incorrectly labels a peak.

Task Action
Change a size 1. Click the size value in the list, or click a peak or peak
value size label in the plot, then select a different value from

the dropdown list.
2. Select the same peak, then click E (auto adjust).
For example, changing the 110 peak to 100, then clicking E

sequentially shifts the 110 size label to the current 100 peak,
the 120 size label to the current 110 peak, and so on.

Delete a peak 1. Click the size value in the list, or click a peak or peak
size label in the plot, then select Delete in the dropdown
list.

2. Select the same peak, then click E
For example, deleting the 110 peak, then clicking E

sequentially shifts the 110 size label to the current 120 peak,
the 120 size label to the current 130 peak, and so on.

4. Click [ v |to recalculate the SQ using the new sizes.

5. Click Override SQ.
The SQI (Sizing Quality Invalid) indicator is displayed:

* In the top right of the Results screen, in the Sizing tab, any sample that is
analyzed with the size standard—Displays SQl: Y.

Note: If SQI does not display in the Sizing tab, click @, then search for
Customize the plot view.

* In the Setup screen Sample Table —Displays in the SQI field.

6. (Optional) To create a new size standard definition for the project using the
modified size matches, click Reanalyze all files with this size standard.

7. Click Done.
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Modify the analysis settings

For a description of analysis settings, click @, then search for Analysis Settings.

1.

2.

Examine low-quality sizing results

In the Setup screen, in the Analysis Settings pane, click £*.

Select the analysis setting from the list, then select Edit.
The following settings are recommended for CLA data analysis. Modify other

settings as needed.

CLA Identifiler™ Plus kit and CLA Identifiler™ Direct

Analysis parameter kit
SeqStudio™, 3500, 3130 3730
Baseline Window Size 51 (default) 51 (default)
Peak Window Size 15 (default) 11
Smoothing Light (default) Light (default)
Size Calling Local Southern (60-460) | Local Southern (60-460)

3. Select Auto analyze, then click Apply.

Adjust Size Quality Flag ranges

1.

2.

In the Setup screen, in the Analysis Settings pane, click £¥.

Select an analysis setting, then click Edit.

Click the Sizing Settings tab.

Click Quality Flags.

Adjust the low, medium and high ranges as appropriate.

= Quality Flags

Size Quality Status

0 oo
0.25

Set the pass/fail status of the size standard. If samples fall

in the low quality range, peaks will not be sized. If samples fall
in the medium or high quality range, peaks will be sized.
Low Medium High

0.75

5

Figure 10 Quality Flag ranges

@ Drag to adjust the quality flag ranges.

6. Click Save, select the Auto analyze checkbox, then click Apply.
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]
Examine low-quality genotyping results

=2

Examine low-quality genotyping results

Before proceeding, ensure that you have selected the correct panel and analysis
method (which may be instrument-specific) for the data you are analyzing.

About PQVs (Process Quality Value symbols ()]

PQVs are flags that reflect the quality of results. © @ are displayed for GQ
(gentotyping quality) if any peak in the sample does not meet expected thresholds.
is displayed for individual PQVs in the genotypes table.

Thresholds are set in the Peak Quality and Quality flags tabs in the analysis
method.

For definitions of PQVs, click @, then search for Genotyping Quality (GQ) status
and Process Quality Values (PQVs).

Review samples with Suspect and Low Quality GQ values
1. In the Setup screen, click the Analysis summary tab.

2. In the Genotyping analysis results pane, click on the blue number next to ©  or
@ to display the Genotyping tab of the Results screen.

Genotyping
Pass Suspect Low Quality Total

2 2 [ 5

v
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Examine low-quality genotyping results

() Genotypes plot
(@ Genotypes table

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide

Note: You may have to scroll down to view the genotypes table.
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3. Examine the plots for yellow or red marker headers, which indicate that one or
more PQVs have been triggered. You can double-click on a marker header to
zoom on the marker range.

GSS‘HTQ 021511 3?8820 CSF1FO @

0 50 100 150 200 250 300 350
80004
| | P
0 T —— =i N ; FYUEY IS P s

al: 12 al- 27
sz: 140.78 sz: 195.75 @
hi: 13941 ht: 11988
al 13 al 22
577144 84 sz: 199.75
ht- 6801 ht: 5876

CW_A1_Sample_01_IF_SeqSt_CLA_v1.fsa

D351358 THO1 @ D165539 D251338 @

0 50 100 150 200 250 300 350
2000 q _'| “ J‘
4000 | I j
QMJJ‘.J WL A A pray) "
@ @ ak 17
sz:313.84
ht 15144

(D Yellow marker header
(2 Red marker header

4. Proceed to “Review PQVs of samples with Suspect and Low Quality GQ or PQV
values” on page 58.

Review PQVs of samples with Suspect and Low Quality GQ or PQV values

1. Display the genotypes results screen (see “Review samples with Suspect and
Low Quality GQ values” on page 56).

2. Scroll down to view the genotypes table, then double-click a row with a ()
GQ or PQV result.
The associated marker is selected in the plot.

Note: You may have to scroll to view the selected marker. Double-click the
marker header to zoom.
The following figures are examples of ( and @ GQ results:

* Figure 11 shows a @ GQ result that is caused by an off-ladder allele (OL
peak label and BIN PQV).

* Figure 12 shows a ©  GQ result is caused by a peak height ratio that does
not meet the threshold (PHR PQV).
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Size Matching
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(1) Double-click a row
@ Associated marker is selected in the plot

Size Matching

Plot Settings v

I‘ Enter search term b4 Type: Sample GQ: Fail

GQ... sa Fil...  Well #

Status S obmsm T | '@
185 190 195 200 205 210 215 220 225 230 235 240 245 25
5000 |
4000
Ak Cl A
al: 27
1 i
® @® c. Eod (%] 2
o s2:199.75
nt: 5876

[\l 3

Total ltems: 5 (Selected ltems: 1) —

Genotype Table U A Enter search term X
Marker Dye C... Allale 1 Allale 2 Size 1 Size 2 BIN LPH SPU AN BD XLTK PHR CC GQ
D138317 12 oL 23212 239.27 A [ | [ | [ | [ | [ | A NA [ ]
D21511 Blue 27 28 19575 19975

=6

Figure 12 Example 2

(1) Double-click a row
(2) Associated marker is selected in the plot

3. As needed, edit alleles. For information, click @, the search for Review, edit
and add alleles.
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Export the genotypes table

60

You can export the genotypes table for reference when you compare the genotypes
to the ATCC database.

. Open the project that contains the samples of interest.

2. Click the Results tab.

B
° Set analysis options then analyze 5 samples

Size Standard Edit SaveAs Panel

. Click the Genotyping tab.

Setup Results

- &Ze hhtd.“"g I

- Scroll down to view the genotypes table, then display the columns that you want

to export.

. Scroll to the top of the screen, then select Actions » Export Genotypes Table.

. Select the location to save the file, then click Export.

If the web browser is configured to prompt before saving, navigate to the
location to save, then click Save.

If the web browser is not configured to prompt before saving, the file is saved to
the Download folder.
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Verify cell line identity using the ATCC database

Cell line identity can be verified by uploading genotypes to the ATCC cell line STR
database. The ATCC database requires you to enter genotypes for 8 specific loci, all
of which are present in the Applied Biosystems™ CLA STR kits.

1. In a web browser (for example, Google™ Chrome™), navigate to www.atcc.org/
STR_Database.

Note: Click View our brief tutorial before starting if you are not familiar with
this website.

2. Click Please log in to search, then log in or create a user profile.

Login | Create a Profile | Quick Order | = (0 items) | USA~| 1.800.638.6597

ATCC | CredibleleadstoIncredible™ Search by Keyword or Catalog m

pducts Services Standards Resources Support About

Home » STR Database

WHAT'S IN YOUR

FLASK? SEARCH THE STR DATABASE

lr;:‘isgjlﬁEre”n?ilg:ﬁroen”;akrigg cell As part of our continuing efforts to characterize and authenticate the cell lines in the Cell Biology collection,
recIuisite for pub”caﬁgn and ATCC has developed a comprehensive database of short tandem repeat (STR) DNA profiles for all of our human
funding agencies a requirement cell lines. View our brief tutorial before starting.

for grant support.

Learn more »

1. 3TR Profiling Analysis
2. Matching Algorithm
3. Interrogating the Database

Please log_in to search

3. Refer to the genotypes from the file you exported, then enter the genotypes in
the ATCC screen.

4. Click Matches >= 80%.

After a few minutes, a list of cell lines in the ATCC database that match the
STRs present in the test sample is displayed.
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Analyze data with GeneMapper "
Software

X

B Overview of GeneMapper™ Software .............ccoviiiieiieennnine.n.. 62
B Allelic ladder requirements for CLA dataanalysis ......................... 63
B Names and versions of settings files used in this section .................. 63
B Set up the GeneMapper™ Software for CLA analysis (before first use of

the Kit) ... e 64
B Create a project and analyze sample files with GeneMapper™ Software .... 72
B Review analyzed results in the sample and genotypestable ............... 74
B Examine low-quality sizingresults ........ ... .. 74
B Examine low-quality genotypingresults ......... .. ... . i, 82
B Display and zoomonsampleplots ........... ... .. i, 83
B Display and zoom genotype plots ........... i 85
B Exportthegenotypestable ........ ... .. i 87
B \Verify cell line identity using the ATCC database ......................... 87

This chapter contains brief procedures. For more information on using the software,
click @ (Help) or select the Help menu.

For information on known artifacts in STR kits, see “Application notes” on page 109.

Overview of GeneMapper  Software

GeneMapper™" Software is a flexible genotyping software package that provides DNA
sizing and quality allele calls for all Applied Biosystems™ electrophoresis-based
genotyping systems. GeneMapper Software helps increase data processing
efficiency with a multiuser, client-server deployment. The software uses Process
Quality Values (PQVs) for automated identification that reduces data review time for
high throughput genotyping. In addition, the security and audit features help users
meet 21 CFR 11 requirements.

For information on obtaining the GeneMapper™ Software, contact your local field
application specialist.

Note: You may observe minor differences in results if you analyze the same data in
the Microsatellite Analysis Software.
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Allelic ladder requirements for CLA data analysis

¢ CLA analysis requires at least one allelic ladder sample per run folder. Perform
the appropriate internal validation studies before you use multiple allelic ladder
samples in an analysis.

For multiple allelic ladder samples, the GeneMapper™ Software calculates allelic
bin offsets by using an average of all allelic ladders that use the same panel in a
run folder.

¢ Allelic ladder samples in an individual run folder are considered to be from a
single run. When the software imports multiple run folders into a project, only the
ladders in their respective run folders are used for calculating allelic bin offsets
and subsequent genotyping.

* Allelic ladder samples must be labeled as "Allelic Ladder" in the Sample Type
column in a project. Analysis will fail if the Allelic Ladder Sample Type is not
specified.

* |Injections containing the allelic ladder must be analyzed with the same analysis
method and parameter values that are used for samples, to ensure proper allele
calling.

* Alleles that are not in the allelic ladders do exist. Off-ladder (OL) alleles can
contain full and/or partial repeat units. An off-ladder allele is an allele that occurs
outside the bin window of any known allelic ladder allele or virtual bin.

Note: If a sample allele peak is called as an off-ladder allele, verify the sample
result according to your laboratory protocol.

Names and versions of settings files used in this section

The names and version numbers of the settings files that are shown in this section
may differ from the names and version numbers that you see when you download or
import files.
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Set up the GeneMapper™ Software for CLA analysis (before first
use of the kit)

About importing files into the GeneMapper™ Software database

Before you use GeneMapper™ Software to analyze CLA data for the first time, you
must import the latest settings files (see “(If needed) Download newer versions of
panel and bin files” on page 66).

IMPORTANT! Settings files are instrument-specific. Ensure that you import files for
the instrument that corresponds to the data you will analyze.

Note: The names and version numbers of the files that are shown in this section may
differ from the file names and version numbers that you see when you download or
import files.

If you need help to determine the correct files to use, contact your local field
applications scientist or technical support.

File to import File type Description See

Defines the markers (loci) that are being interrogated.

IMPORTANT! Use only panel and bin TXT files that are
Panel XT provided by Thermo Fisher Scientific. If you use panel and bin

files that you create in the GeneMapper " Software, you may 67
see off-ladder alleles.
Bins TXT Defines bins (location of expected alleles) for each marker.
Analysis Method XML Defines thle settings used for peak detection, allele calling, and 70
peak quality flags.
Size Standard XML Defines the sizes of the fragments present in the size standard. 69
Table Settings XML Hide or show columns, filter results, sort order.
Defines settings for electropherogram plot display including 1

Sample Header Settings, Genotypes Header settings, Sizing
Table settings, peak labels settings, and display settings for
Sample and Genotype plots.

Plot Settings XML
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Workflow: Set up GeneMapper™ Software
“Check panel and bin file versions on your computer” on page 65
v
“(If needed) Download newer versions of panel and bin files” on page 66
v
“Import panel and bins” on page 67

v

“Import analysis method” on page 70
v

“Import the size standard” on page 69
v

“Import table settings and plot settings” on page 71

Check panel and bin file versions on your computer

1. Start the GeneMapper™ Software, then log in with the appropriate user name
and password.

2. Select Tools » Panel Manager.

3. Check the version of files that are currently available in the Panel Manager:

a. Select Panel Manager in the

i
navigation pane. i1 Panel Manager

File Edit Binz View

b. Expand the Panel Manager “ 5 A | .
folder and any subfolders to e e el '
identify the analysis file version -
that is already installed for your
kit choice.

...
i Panel Manager

File Edit Bins View

i x | i a1 m o Bin Set: Example_GM_Bin

Fanel Hame

———
1 [E=ample_GM_Panel{CLA_v )

4. Check the version of files available for import into the Panel Manager:

a. Select Panel Manager, then select File » Import Panels to open the
Import Panels dialog box.
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b. Navigate to, then open the Panels folder, then check the version of panel,
bin, and stutter files installed.

5. Check for newer versions of the files on the website as described in the next

procedure.

(If needed) Download newer versions of panel and bin files

66

Go to www.thermofisher.com.

In the search field, type CLA, then select the kit of interest.

Il'éelrznr?ffslneg Popular Applications & Techniques Shop All Products Services Support

Search All v CLA

Search suggestions
A44660 - CLA IdentiFiler™ Plus PCR Amplification Kit
A44661 — CLA IdentiFiler™ Direct PCR Amplification Kit

A44562 - CLA GlobalFiler™ PCR Amplification Kit

3. Scroll down to the Documents section.

Documents

Product literature

i~ Application Guide: SeqStudio Genetic Analyzer

J- Application Mote: Authenticating human cell lines using the |dentifiler kits and capillary electrophoresis platforms
J Brochure: DNA fragment Analysis by Capillary Electrophoresis

l@entifiler Data Analysis File Download CLA VD

J Matching identities of iPSCs and donors using Identifiler STR profiling kits
) Technical Note: Confidently identify human samples using theCLA Identifiler and CLA GlobalFiler STR kits

J- White Paper: Matching identities of iPSCs and donors using CLA Identifiler STR profiling kits

If this is the first time you are using the GeneMapper™ Software, or if a newer
version of the download file is available, download the new file.

Unzip the file.

The ZIP file contains a separate folder for each instrument type. Each instrument
folder contains a folder with Microsatellite Analysis Software settings (ignore this
folder) and GeneMapper ™ Software settings.

The GeneMapper " Software folder contains IF_Analysis_Settings_CLA_vX
folder, which contains the settings needed to analyze data in the GeneMapper "
Software.
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Import panel and bins

IMPORTANT! Use only panel and bin TXT files that are provided by Thermo Fisher
Scientific. If you use panel and bin files that you create in the GeneMapper™
Software, you may see off-ladder alleles.

1. Start the GeneMapper" Software, then log in with the appropriate user name
and password.

2. Select Tools » Panel Manager.

3. In the left pane, click Panel —
Manager. it Panel Manager
Note: If you do not click on Panel File Edit Bins View
Manager, the import commands are O | i | i

not available.
..

4. Import the panel file:
a. Select File » Import Panels to open the Import Panels dialog box.

b. Navigate to, then select, the appropriate GM_Panel_CLA_vX.txt you
obtained in “(If needed) Download newer versions of panel and bin files” on
page 66.

i Import Panels e

Look in: GeneMapper_Analysis settings o |‘_"“fE

s = Example_ GM_AM_CLA v¥xml
~3| = Example_GM_Bins_CLA vXixt

S S B Example_GM_Panel_CLA_vK.txt

=] Example_GM_Plot_Set CLA Xt

- = Example_GM_SizeStd_CLA vXxml
Desktop =] Example_GM_Table_Set_CLA_wi.xt
E File name: Example_GM_Panel_CLA_vX.txt Impart
Documents  Files of type: | all Files r Cancel
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¢. Click Import.

Note: Importing this file creates a new folder in the navigation pane of the
Panel Manager. This folder contains the panel and associated markers.

... ]
Lis Panel Manager

File Edit Bins View

IE

w > | W M M | W ™ | 5inSet: |Example_GM Bins_CLA_vX

[ 4, Panel Manager Panzl Name

e iy Identifier_CLA_vX 1 [Example_GM_Panel_CLA_vx

Import the bins file:
a. Select the Identifiler folder in the navigation pane.

e
1w Panel Manager

File Edit Binz View

w > | @ M M | W ™ | BinSet: |Example_GM_Bins_CLA_vX

EI---d%,PanEI Manager Fanel Name
e (i Iclentifiler_CLA_vX 1 [Example_iM_Panel_CLA_vx

b. Select File » Import Bin Set to open the Import Bin Set dialog box.

c. Navigate to, then select, the appropriate GM_Bins_CLA_vX.txt file.

™ Import Bin Set et

Look in: GeneMapper_Analysis setti... - 5

i"'f‘:j 1= Example_GM_AM_CLA vExml

. Example_GM_Bins_CLA_wX.txt
Recent Items D Example_GM_Panel_CLA vt
=| Example_GM_Plot_Set_CLA_vX.bxt
- |Z| Example_GM_SizeStd_CLA vixml
Desktop =| Example_GM_Table_Set_CLA_vX.tet

E File mame: Example_GM_Bins_CLA_v¥.txt Import

Files of type: | All Files s Cancel

Documents
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6. (Optional) View the imported panels and bins in the navigation pane: Double-
click the Identifiler folders in the left pane.

The panel information is displayed in the right pane and the markers are
displayed below it.

E Panel Manager >
File Edit Bins View
g > | @M M | W ™ | inset: Example GM_Bins CLA vX v ERE BEEEEEN
E|"',5%.\,P‘EHE| Manager ~ Universal |Mater Name Lye Colo |[Min Size |Max Size Control Alleles Marker | Maker Analysis Method
-3 Identifier_CLA_yX 1 EERE Blue 118.0 |1835 |13 4 0.1032
B8 @ Example_GM_Panel_CL 2 DZ1511 Blue 1845 |247.5 |30 4 0.1067
- DBS51179
D251 3 D75820 Blue  |251.0 |298.5  |10,11 4 0.0969
.. D75820 4 CSFIPO Blue  |302.12 |348.63 |10,12 4 0.092
- CSF1PO 5 D351358 Green |98.0  |148.0 |14,15 4 0.1227
- D351358 & THOL Green |159.0  |205.0 |8,9.3 4 0.0408
Sgéﬂ? 7 D135317 Green  |205.65 |250.16 |11 4 |0.09
. D165538 3 165539 Green  |255.3  |301.81 |11,12 4 0.1039
- D251333 3 D251338 Green  |304.8  |370.31 |19,23 4 0.1244
- D135433 10 D195433 velow [101.0  |148.0 14,15 4 01121
ggqx 11 WA Yelow |151.0 |213.5  |17,16 4 0.1245
- D13S51 12 TPOX vellow  |216.99 |260.99 |3 4 0.0638
- AMEL 13 18351 velow  |264.49 |350.0  |15,19 4 0.1363
- D35818 v |12 AMEL Red  [1080  [t140  |x a 0.0
a &Rehren;:amples 15 D55318 Red 128.0 |180.0 |11 4 0.1006
16 FaA Red  |206.25 |360.0 |23,2% 4 0.1303
£ >
K Cancel Apply

7. Click Apply, then click OK to add the panel and bins to the GeneMapper™
Software database.

IMPORTANT! If you close the Panel Manager without clicking Apply, the
panels, bin sets, and marker stutter are not imported into the software database.

Import the size standard

Import the latest size standard from the website into the GeneMapper™ Software
database:

1. In the GeneMapper" Software, select Tools » GeneMapper Manager.

2. In the GeneMapper Manager window, select the Size Standards tab.
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())

3. In the Size Standards tab, click Import.

- GeneMapper Manager x
Projects Aanalysis Methods Table Settings
Plot Settings Cluster Plot Settings Matrices Size Standards SNP Sets Report Settings
Narie \Size Shandand Dye [Last Saved {Cwner Type
SMPlex_48plex_vl Orange 2003-0%-26 11:16:34.0 |gm Basicj Advanceq »
GSE00LIE (Crange |2008-06-27 11:03:44.0 [gm Basic/ Advance
GSE0OLIZ +Mormalization | Orange 2008-06-27 10:52:54.0 |gm Basic/Advance
G5500R0K Red 2008-04-17 14:58:46.0 |gm Basic]Advance
GS500(-35,-250,-340)R 0% Red |2008-08-11 17:04:14.0 am Basic ddvance
GS500(-35,-250,-340)L1Z  |Ovange |2008-04-17 14:52:07.0 |gm Biasic) Ao ance:
GSS00{-250)R0% Fed 2008-04-17 14:56:15.0 |gm Basic/Advance:
G5S00(-250)L 17 Orange 2002-08-20 13:02:36.0 |gm Buasic) Advance:
G5400HDRON Red |2002-08-2013:02:36.0 [gm Biasic/ Advance
[ |Zemmnnny Dad Er R R TP [acicind s
[ < >
New... Open... Save As... Import, . R;_ Bxport... Delete
P\

4. Navigate to, then select, the appropriate GM_SizeStd_CLA_vX.xml file you
obtained in “(If needed) Download newer versions of panel and bin files” on
page 66.

™™ Import Size Standard Method it

Look in: GeneMapper_Analysis settings w £

P /£ Example_GM_AM_CLA vXxml
%ﬁ Example_GM_SizeStd_CLA_vX.xml
Recent Items
- File name: Example_GM_SizeStd_CLA_v¥.xml Import
Desktop Files of type: | ML Files (*.xml) e Cancel

5. Click Import.

6. Click Done.

Import analysis method
1. In the GeneMapper™ Software, select Tools » GeneMapper Manager.

2. In the GeneMapper Manager window, select the Analysis Methods tab.

3. In the Analysis Methods tab, click Import.
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4. Navigate to, then select, the GM_AM_CLA_vX.xml file for your instrument type

5.

that you obtained in “(If needed) Download newer versions of panel and bin
files” on page 66.

E Import Analysis Method )-(
Look in: GeneMapper_Analysis settings w &
£m B Example GM_AM_CLA_vXxml
l_-j |Z Example_GM_SizeStd_CLA_v.xml
Recent Items
File name: Example_GM_AM_CLA_vX.xml Import
Desktop
Files of type: | yML Files (=, xml) Wy Cancel
Click Done.

Import table settings and plot settings

1.

Start the GeneMapper™ Software, then log in with the appropriate user name
and password.

Select Tools » GeneMapper Manager.
In the Table Settings tab, click Import.

Navigate to, then select, the appropriate GM_Table_Set_CLA_vX.xml file you
obtained in “(If needed) Download newer versions of panel and bin files” on
page 66.

Click Import.
Repeat for plot settings.

Click Done.
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# Chapter 6 Analyze data with GeneMapper™ Software
Create a project and analyze sample files with GeneMapper™ Software

Create a project and analyze sample files with GeneMapper "

Software

1. If a project is currently open, select File » New Project, then select Generic.

= New Project

X

Project Type

@® Benerig
() Microsatellite
() SNaPshot®
() OLA Analysis
(") SMPlex™

() AFLP

K Cancel

In the Project window, select File » Add Samples to Project, select the folder
that contains the sample files, click Add to List, then click Add.

™= Add Samples to Project *
Edit View

Files  GM Database Samples To Add:

3 Example data files
Metwork

=8 This PC
=y
Example data

= . Example data filles
i-| ] AZ_Sample_01.fsa

i-| | B3_Sample_02.fsa

i | C3_PosCirl_0D3.fsa
i | D2_NegCtrl_04.fsa

------ | | E3_Ladder_05.fsa

Add To List ==

Y Clear
Options...

Cancel

Add v«ﬂd & Analyze

3. Select the table setting that determines the columns that are displayed in

samples table and genotypes table: Click the arrow next to the Table Setting
list, then select the setting.

Example Table Settings %@

Table Setting:
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4. Apply analysis settings to the samples in the project:

a. Click the Sample Type field in the Samples

first row, then select the Statuz |Sample Name Sample Type |4
appropriate sample type. 1 & | sampleo Sampie o !
d e p

Repeat for each sample. 2 % |sampleo2 p—— |[
3 1 Sampleda z\isi' Vf ddon o

elC Laaaer o

IMPORTANT! You need at least 2 B [sampleds  Jorimerroaus !
1 allelic ladder in the project. 5 Bk  |Sampleds  |Megative Contrdl

Repeat for the Analysis Method, Panel, and Size Standard fields. Select
the objects you imported in “Set up the GeneMapper™ Software for CLA
analysis (before first use of the kit)” on page 64.

IMPORTANT! Analysis method is instrument-specific. Ensure that you
select the appropriate analysis method for the sample files in the project.

. If this is the first time the analysis method is used: Double-click the analysis

method in the first row, click the Allele tab. Select the bin set you imported
in “Set up the GeneMapper™ Software for CLA analysis (before first use of
the kit)” on page 64.

Fill in remaining rows.

Note: You can fill in the first row, click the column header to select all rows,
then use Ctrl+D to fill down remaining rows.

5. Click = (Analyze), enter a name for the project (in the Save Project dialog
box), then click OK to start analysis.

The status bar displays the progress of analysis as a completion bar.

The table displays the row of the sample currently being analyzed in green
(or red if analysis failed for the sample).

When analysis is complete, the SQ field displays a PQV result, and the
Genotypes tab is available.

Samples  Genotypes

Statuz | Sample|Sample Type | Analysis Method |Panel Size Standarc | 5Q Wyell
1 A Sample Example CLA Ar | Example_Cl|Example CLA, 0 A0
2 E1 Sample Example CLA Ar | Example_Cl Example CLA B
3 oy Sample Example CLA Ar | Example_Cl|Example CLA, cm
4 Ol Sample Example CLA Ar | Example_Cl|Example CLA ulny}
5 E1 Sample Example CLA Ar | Example_Cl|Example CLA, EO1
5] F1 Sample Example CLA Ar | Example_Cl|Example CLA F1
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# Chapter 6 Analyze data with GeneMapper™ Software
Review analyzed results in the sample and genotypes table

Q

Review analyzed results in the sample and genotypes table

1. If you have not already done so, select the table setting that determines the
headers that are displayed in sample and genotype plot: Click the arrow next to
the Table Setting list at the top of the screen, then select the setting.

2. In the samples table, examine the SQ (sizing quality) result.

Genotypes

Status |Sample File Sample|Sample Type | &nalysis Method |Panel Size Standarc |Run Mame Fun Date & Time S0
1 A1_A1_Sample_2 A1 Sample Example CLA &r |Example_Cl Example CLA |GF SeqStudio | 2015-08-11 15:38:51 0
2 B1_B1 _Sample_2|B1 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio | 2018-06-11 15:38:51
3 C1_C1 _Sample_2 | C1 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio |2015-06-11 15:35:51
4 [ _B1 _Sample_2 |01 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio |2015-06-11 15:35:51
5 E1_E1_Sample_21|E1 Sample Example CLA Ar |Example_Cl|Example CLA |GF SeqStudio [2015-06-11 17:37:52

3. Click the Genotypes tab, then scroll to the right to examine the PQV flags (see
“About PQVs (Process Quality Value symbols )” on page 82.

Note: To change the sort order or to display additional PQVs, click ﬁ (Table
Settings), click the Sample or Genotypes tab, then select additional PQVs.

Samples CGEnot/oeD)

Sample File Samg |Panel harker Alele 1 |allele 2 |Size Size 2 Height 1 |Height 2 |PHR &M
A1_&1_Sample_2 |A1 | Example_CLA_Pa | AMEL
HE_HE_Sample_21|HE | Example_CLA_Pa | AMEL
A1_81 _Sample_2 |A1 | Example_CLA_Pa|CSF1PO
C4_C4_Sample_21|C4  |Example_CLA_Pa|CSFIPO |9 11 20506 [303.08 |2309 5200
C5_C5_Sample_21|/C5  |Example_CLA_Pa|CSFIPO |9 11 29542 |303.07 (3036 6126

P00

| e =

Examine low-quality sizing results

Before proceeding, ensure that you have selected the correct size standard and
analysis method (which may be instrument-specific) for the data you are analyzing.

View data collection settings

1. In the Project window, select a sample in the sample table, then select
View » Sample Info.

Scroll down to view all settings.
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-
=
S

.
=%

Info  RawData EFT Data

Sample Information

Sample File : Al Rl Sample 20120611
Sample Origin Path : D:W\Customer Data\Mart
Jackson‘\Al Rl Sample 20180611 153851.faa

Status Message : Good

File Source : Disk media

Size Standard Normalization : No

Error Message

Message : None

Current Settings

Sample Type : Sample

Panel : Example CLL Panel G

Size Standard : Example CLA Size Star

Matrix : None

Enalvysis Method : Example CLA Analy3is
Peak Detection Mode : Rdvanced

Analvsis range (data point) start: 2000 stop: 10000
S5izing range (bp) start: &0.0 stop: 500.0
Baseline window (data point): 33

2. To return to the Project window, click Project in the left pane.
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Examine EPT and raw data
Review the EPT (ElectroPherogram Telemetry) plot to identify instrument performance
issues that can affect size quality.

Review the raw data to evaluate anomalies, the causes of poor size-calling, and to
determine the start and stop points for analysis. The start point for data analysis
occurs after the primer peak and before the first sizing peak. The stop point for
analysis occurs after the last sizing peak.

1. In the Project window, select a sample in the sample table, then select
View » Sample Info.

2. Click Raw Data to view the raw data plot.

Info RawData EPT Data
Al_Al_Sample_20130611_153351.fsa

0 2000 4000 EO0D 2000

20000

20000

40000
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Examine low-quality sizing results

3. Click the EPT tab to view the EPT plot.

Info RawData EFTData

ann

EO0

400

200

1400

1200

000

~A1_A1 Sample_20180611_153851.fsa

20000

40000

EOO00

0000

EF Voltage

Laser Power |

4. To return to the Project window, click Project in the left pane.

Review size matches

1. In the sample table, select a sample with @ SQ, then click ||| (Size Match

Editor).

View Tools Help

'
¥
254

W,
O
( ({

&
| ¢

1\
[l

i @ | EI(J_U} @ | D @ | Table Setting: Identifiler Direct Table Settings

vE| LS|

Samples  Genotypes

Status

Sample Mame

Sample Type

Analysis Method

Panel

|Size Standard

Lane

Wil

Sample01

Sample02

Sampled3

Megative Contro

Sample

Example _AM__CL

Example  AM_CL

Example _ AM _CL

Example Panel (

Example_ Panel C

Example Panel (| Example SizeStd

| Example_ SizeStd

Example SizeStd

D02

S}

Sample04

Pasitive Cortral

Example _ AM__CL

Example  Fanel C

Example SizeStd

Cos

Sample0s

Allelic Ladder

Example _ AM _CL

The Size Match Editor is displayed.
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Examine low-quality sizing results

360001
32000:
2SDDD:
24000 1
ZDDUD:
1BDDD:
12DDD:
EDUU:
A000 4

"’.":":S Chapter 6 Analyze data with GeneMapper™ Software

£ 0 R EOEIEY 24PEPE0 280 200 EMIEE 0400

a

oo U ] T oy EO0D

(@) Primer peaks
(2 Size standard peaks

2. Zoom in on the size standard peaks:

a. Place the cursor on a number in the y-axis, then click-drag to the right.

SEDDD:
32000:
23000:
24000:
2DDDD:
1EDDD:
12000:
SDDD:
4000 1

20 TERaE AN 20660 280 300REEER0-400

0

000 . 2000 4000 A000 EQ00

b. Place the cursor on a number in the x-axis, then click-drag up.

78

26000
32000
28000
24000 1+
20000
13000:
12000:
2000 I

A

B0l OTiZR 080 SO0RIZ) Z4ESEE0 280 200 o

WD 200 1200 100 2000 2400 2200 2200 2600 4000 4400
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Examine low-quality sizing results

You may have to repeat these steps a few times to zoom on the size standard
peaks.
To unzoom to full range, double-click a number in the x-axis.

3. When the trace is zoomed and you can distinguish peaks, compare the profile
you observe to the profile for the GeneScan™ 600 LIZ" Size Standard v2.0
(Figure 2 on page 11). Determine if all size standard peaks are correctly labeled.

In the example below, 2 peaks were unlabeled, and all remaining peaks are
incorrectly labeled.

1530:
1330:
1130:
480
Ta0
SBD:: 100 111"2[!
3801

180+

* o
1625 1825 2025 2225 2425 2EB25 28237 3025 8225 8425

4. Add or delete peaks, or change values, as needed (see “Modify size matches”
on page 80).
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Modify size matches

If the software does not correctly detect size standard peaks, you can modify the size
matches, then apply the modified size standard definition to all selected samples in
the project.

1. Display and zoom on the trace in the Size Match Editor (see “Review size
matches” on page 77.

2. Use Figure 2 on page 11 as a reference to assign the correct sizes to the peaks:
Right-click an unlabeled peak, select Add, then double-click the correct size (in
this example, 240).

Option Action

Change a size value Double-click the size value in the trace, then select a
different value.

Add a size value to a peak | Right-click an unlabeled peak, select Add, then select
a size value.

Note: If you cannot select a peak, it indicates the
peak is below the Peak Amplitude Threshold in the
analysis method and is not detected.

TE
180 240 280
200 214

220

Add.. B SelectSize X

Delete 30.0 "
100.0
-y Change... Pd114.0
1 2560 27E0 2480 21120.0
140.0
160.0
180.0
200.0
214.0
220.0
240.0

Delete a size value from a | Right-click a labeled peak, then select Delete.

peak
Override the SQ After you correct all size assignments, click
Override SQ.
3. Click Apply.

4. Reanalyze samples to apply the new settings.
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Modify the analysis settings

For a description of analysis settings, click @, then search for Analysis Method
Editor. View the help topics for Microsatellite settings.

1. In the Project window, double-click the analysis method for the sample of
interest.
2. Modify the settings.
The following settings are recommended for CLA data analysis. Modify other
settings as needed.
CLA Identifiler™ Plus kit and CLA Identifiler” Direct
Analysis parameter kit
SeqStudio™, 3500, 3130 3730
Baseline Window Size 51 (default) 51 (default)
Peak Window Size 15 (default) 11
Smoothing Light (default) Light (default)
Size Calling Local Southern (60-460) | Local Southern (60-460)
3. Click OK.

4. Reanalyze samples to apply the new settings.

Adjust Size Quality Flag ranges

1.

In the Project window, double-click the analysis method for the sample of
interest.

Click the Quality Flags tab.

Adjust the settings as needed.

For definitions of PQVs, click @, then click the Search tab, type the PQV name,
then click List Topics.

Click OK.

Reanalyze samples to apply the new settings.
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Examine low-quality genotyping results

About PQVs (Process Quality Value symbols [ 1 ;- @)

PQVs are flags that reflect the quality of results. ;. and @ are triggered if a peak
does not meet expected thresholds.

Thresholds are set in the Peak Quality and Quality flags tabs in the analysis
method.

For definitions of PQVs, click @, then click the Search tab, type the PQV name, then
click List Topics.

Review PQVs of samples with Suspect and Low Quality GQ or PQV values

1. Click the Genotypes tab, then scroll to the right to examine the PQV flags (see
“About PQVs (Process Quality Value symbols )” on page 82.

Note: To change the sort order or to display additional PQVs, click ﬁ (Table
Settings), click the Sample or Genotypes tab, then select additional PQVs.

Samples
Sample File Samg | Panel Marker Allele 1 (Allele 2 |Size Size 2 Height 1 |Height 2 |PHR |&M  |G3
1 A1_81_Sample_2 A1 |Example_CLA_Pa | AMEL o
2 HE_HE_Sample_21|HE  |Example_CLA_Pa | AMEL o
3 A1_41_Sample_2 | A1 |Example_CLA_Pa|CSF1PO o
4 C4_C4_Sample_2|C4  |Example_CLA_Pa|CSFIPO |9 11 29506 [30308 |2309 52490 &
5 C5_C5_Sample_21|C5  |Example_CLA_Pa|CSFIPO |9 11 29512 |[303.07  [3036 6126 &
2. To view the electropherogram for a marker, select the rows in the table that
correspond to the marker, then click [jii| (Display Plots).
Figure 13 shows a @ GQ result that is caused by:
* A peak height ratio that does not meet the threshold (PHR PQV).
* The detection of 3 peaks in the marker (AN PQV).
Sample File Sample Name FPanel barker as EIN |PHR |LFH AN Ga
AZ_p2_Sample_2 | A2 Example_CLA_P: | 02251045 ||E ||E | ||E | |O i
02251045
A a7 i 101 103 105 107 103 111 113 115 7 114 124 123 125
4000
D I I I
12 15 16
102 43 11142 114 37
S224 578 7787

Figure 13 Example 1

3. As needed, edit alleles. For information, click @, search for Sample/Genotypes
Plot, then click List Topics. Double-click the Sample/Genotypes Plot topic,
then click Modifying Alleles.
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Display and zoom on sample plots

Display and zoom on sample plots

To view the electropherogram for a sample, click the sample in the sample table,
then click [jiil (Display Plots).

m Samples Plot
File Edit View Tools Alleles Help

Flot Setting: Plot Settings « [N | BE EEEn | In

R | e | s | o

-]

Sample File Sample Hame Fanel as sQ
AZ_AZ_Sample_20120811_193823 f=a A2 Example_CLA_Panel _C | E | E
[D351358 | [unFA | [D165539 =
75 115 155 133 235 275
20000
. AN 1 1
(Mo room for labels )
<
AZ_fZ Sample_20180811_193223 f== A2 Example_CLA_Pansl_C E E
[D8s1178 [DZ1511 ] [D18551
75 115 155 133 235 275
40000
20000
" o lh L 1 AN
Mo room for [abels
<
A2_A2_ Sample_20180611_193823 fsa A2 Example_CLA_Panel G E E
D253 195433 |[THIT | [FGA
75 115 155 135 235 275
20000
o ‘1 oon Li AN

Mo room for [abels

Note: To show fewer traces on a screen and make room for peak labels,
change the Panes setting to 2.

For more information on the samples plot, select Help » Contents and Index.
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|Eg;5j GeneMapper® Software Online Help

.
Hide Back Forward Print

¥ Appli
Contents l Index ] Search ] h% Bigfysetgms P
----- [£] Computer Requirements Samples/Genotypes Plot
----- @ Supported Instruments and Softw
..... [] New Features in v5 The Samples and Genotypes Plots allow you to display el
[]__@ Getting Started de_zta and perform a variety of tasks. The tab,i’tab_le that is
.48 Setting Up Analysis window (the Samples or Genotypes tab) determines the |
' : uses to display electropherogram data.
[]--Q Anahyzing a Project
-4 Examining Data Mote: To display the Samples or Genotypes Plot, select’
- Creating and Edting Reports in the GeneMapper window, then click [iil] (Analysis » Dis
=@ Additional Information
- Software and Database Mairtens You can use the Samples/Genotypes Plot to:
- Troubleshooting
[]..@ Glossary >IZ:is.|:>lIE|\fr electropherogram plots Labels
[]..@ Websites »Modify the plot )Dglete labels .
----- [3] Contacting Life Technologies >Zoom the plot >Display the sllele hist
_____ @ Trademarks Bins >Malc,z room for labels
»Add bins >Maodify labels
»Delete bins Genotype Calls
>Edit bins >Modify alleles
*Modify bins >Rename peaks

2. Select the plot setting that determines the headers that are displayed in sample
and genotype plot: Click the arrow next to the Plot Setting list at the top of the
screen, then select the setting.

3. To zoom on the plot, select View » Zoom, or:

* To zoom on the x- axis, place the cursor on the x-axis at the top of the plot,
then click-drag to the right.

[D3... [vWA ] [1...]C... | [D351358 | | [DT65539 |[CSFIPD | [POX |
n 200 440 100 14a 180 220 260 F00 340 330
2000 —\ 2000
=
1800 \r 1800
1600 1600
1400 1400
1200 1200
1000 1000
200 - aon
500 E00
400 A0
200 200 J L ‘\
: J i e I A SOTIRIN 90 S
11 1 1 1
al 17 n12 al 17 4l 15 4l 12 al 11 al 2
=z 13264 (4 22§ [z 257 60| R O4H1.00 cx 132 A4 3 cx 174 22|15 ez 257 69|71 cx 302,94 sz 351.90
bt 14540 [p3 | 8458 |F61 D134 14540 213z # 2458 16761 10134
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* To zoom on the y- axis, place the cursor on the 0 y-axis, then click-drag up.

i | 11} |
al 17 4l 15 4l 12 al 11 al &
cx 132 64 (3 cx 174 22|15 ez 257 6271 ez 202,94 ez 251.90
(bt 14540 it 2123 B [ht 2458 bt 16761 (bt 10134
a0 - AL < Za +-11) =511 Tt
00
500
400
300
200
100 JML
. Ul ! i
al 17 4l 15 4l 12 al 11 al 2
sz 122,643 cz 1742215 sz 257 69|71 sz 302,94 sz 351.90
14540 FIVERN ] 2458 1a7al 10134

* To unzoom double-click the x-axis.

4. To close the sample plot, click the X in top-right corner of the screen.

Display and zoom genotype plots

1. In the project window, click the

Genotypes tab. g amp|E5 Genoty
2. If you have not already done so, Status Sam}\ a
select the plot setting that [ X Ca

determines the headers that are
displayed in sample and genotype plot: Click the arrow next to the Plot Setting
list at the top of the screen, then select the setting.

3. To view the electropherogram for a marker, click a rows in the table that
correspond to the marker, then click [jii| (Display Plots).
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4. To zoom on the plot, select View » Zoom, or:

* To zoom on the x- axis, place the cursor on the x-axis at the top of the plot,
then click-drag to the right.

o1 ]C. [D351358 | | [D165539 |[CSFIPG | PO ]
0 200 480 100 140 180 220 2E0 300 240 380
2000 —\ q h 2000
1800 \ﬂf 1200
1800 1600
1400 1400
1200 1200
000 000
a00 a0
EOO BO0O
400 400
200 200 L ‘\
0 J 0 U Al i AL P L0 _l L
al 17 n12 4l 17 4l 15 4l 12 al 11 al &
oz 13264 |4 22§ |z 25760 |0 04 51,00 =z 132 64 5 =x 174 .22[15 2x 257 6971 53 304.04 53 351.90
bt 14540 P3|t 2458 (61 D134 it 14540 it 5123 # [t G458 it 16761 [t 10134

* To zoom on the y- axis, place the cursor on the 0 y-axis, then click-drag up.

i | TN I Il

a 0wl

al 17 4l 15 al 12 al 11 4l 8
=% 132,643 sz 174 22|15 sz 257697 55 302.94 5% 351.90
[t 14540 5123 B 8458 it 16761 it 10134
=11 AL A 0 Laun LA &1L LTI
EOO
500
400
300
200
100 JML
: i H U
al 17 41 15 4l 12 al 11 4l &
cx 132643 sz 174 22|15 ez 257 69[.T1 cx 302.94 sz 351.90
it 14540 it 3123 B [t 5458 it 16761 it 10134

* To unzoom double-click the x-axis.
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Export the genotypes table

You can export the genotypes table for reference when you compare the genotypes
to the ATCC database.

1. Open the project that contains the samples of interest.
2. Click the Genotypes tab.

Sample File Samg |Panel arker Alele 1 |allele 2 |Size Size 2 Height 1 |Height 2 |PHR |&N
A1_81 _Sample_2 (A1 | Example_CLA_Pa | AMEL

G
1 o
2 HE_HE_Sample_21|HE | Example_CLA_Pa | AMEL o
3 A4 481 Sample_2 |A1 | Example_CLA_Pa | CSFAPO o
4 C4_C4_Sample_21|C4  |Example_CLA_Pa|CSFIPO (9 1 29506 |303.08 (2309 5240 o
5 C5_C5_Sample_21|C5  |Example_CLA_Pa|CSFIPO |9 1 29512 |303.07 |3036 B126 o

3. Display the columns that you want to export.
4. Select File » Export Table.
5. Select the export file type (the default is TXT).

6. Click Export.

Verify cell line identity using the ATCC database

Cell line identity can be verified by uploading genotypes to the ATCC cell line STR
database. The ATCC database requires you to enter genotypes for 8 specific loci, all
of which are present in the Applied Biosystems™ CLA STR kits.

1. In a web browser (for example, Google™ Chrome™), navigate to www.atcc.org/
STR_Database.

Note: Click View our brief tutorial before starting if you are not familiar with
this website.
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2. Click Please log in to search, then log in or create a user profile.

Login | Create a Profile | Quick Order | = (0 items) | USA~| 1.800.638.6597

ATCC | credibleleadstoIncredible™ Search by Keyword or Catalog m

pducts Services Standards Resources Support About

Home » STR Database

WHAT'S IN YOUR

FLASK? SEARCH THE STR DATABASE

Ir;:i-sgjlﬁErenn?ilgaatiroenn;a:rigg cell As part of our continuing efforts to characterize and authenticate the cell lines in the Cell Biology collection,
reauigite for publication and ATCC has developed a comprehensive database of short tandem repeat (STR) DNA profiles for all of our human
funding agencies a requirement cell lines. View our brief tutorial before starting.

for grant support.

Learn more »

. STR Profiling Analysis
- Matching Algorithm
- Interrogating the Database

Please log_in to search

[T )

3. Refer to the genotypes from the file you exported, then enter the genotypes in
the ATCC screen.

4. Click Matches >= 80%.

After a few minutes, a list of cell lines in the ATCC database that match the
STRs present in the test sample is displayed.
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Troubleshooting

Causes of extrapeaks . ......ccuiiiiri it i e e 89
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D3S1358 marker shoulder and stutter peak examples (N+1, N-4, and N+4) . 93
POP™ polymer-specific artifact examples (N-1 and N+1 shoulder peaks) ... 93
D19S433: off-ladder alleles caused by dye pullup ....................... 95

General troubleshooting ...........co i 96

Causes of extra peaks

Stutter definition

Peaks other than the target alleles may be detected on the electropherogram.

Causes for the appearance of extra peaks include stutter products, incomplete 3" A
nucleotide addition (at the n-1 position), dye artifacts, and mixed DNA samples.

Stutter is a well-characterized PCR artifact that refers to the appearance of a minor
peak one repeat unit smaller than the target STR allele product, or less frequently,
one repeat larger (Butler, 2005; Mulero et al., 2006). Sequence analysis of stutter
products at tetranucleotide STR loci has revealed that the minus stutter product is
missing a single tetranucleotide core repeat unit relative to the main allele (Walsh et
al., 1996).

Plus-stutter is normally less frequently observed than minus-stutter in STR loci with

tetranucleotide repeats.

For the STRs in the CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification
Kits (tetranucleotide repeats), minus stutter peaks can be observed at 4 bp below an

allele peak. Plus stutter peaks can be observed at 4 bp above an allele peak.

1 2
5 — caTa GATA
TN [N |
3’ i CTAT ]| i CTAT i CTAT i
1 2 3

Figure 14 Plus stutter is caused by slippage in the top DNA strand
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Stutter peak analysis settings

The proportion of the stutter product relative to the main allele (percent stutter) is
measured by dividing the height of the stutter peak by the height of the main allele
peak.

3’ A nucleotide addition peak definition

Many DNA polymerases can catalyze the addition of a single nucleotide
(predominantly adenosine) to the 3’ ends of double-stranded PCR products (Clark,
1988; Magnuson et al., 1996). This nontemplate addition results in a PCR product
that is one nucleotide longer than the actual target sequence. The PCR product with
the extra nucleotide is referred to as the “+A” form.

Artifact peak definition

Artifacts and anomalies are seen in all molecular biological systems. Artifacts are
typically reproducible. Anomalies are non-reproducible, intermittent occurrences that
are not observed consistently in a system (for example, spikes and baseline noise).

Stutter peak analysis settings

The parameters are used to identify and label stutter peaks for a marker in an
electropherogram.

Parameter Description Location

Repeat unit Number of bases in the repeat unit for the designated marker. For Panel Manager
example, a tetra repeat unit contains 4 bases.

Can be used to determine the number of basepairs from an allele
peak at which stutter may be observed.

Stutter ratio Ratio of secondary peak to allele peak below which a peak is Analysis method
considered to be stutter and is filtered (is not labeled). Allele tab

The GeneMapper™ Software provides settings for minus and plus
stutter peaks.

If Use marker-specific stutter ratio if available is selected, the
minus stutter ratio in the Panel Manager is used instead of the
minus stutter ratio in the analysis method.

Note: The CLA analysis method (Allele tab) specifies Use marker-
specific stutter ratio.
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Guidelines for troubleshooting and data interpretation CLA

Parameter Description Location
Stutter distance Size window around an expected stutter peak (because a stutter Analysis method
peak may not migrate at an exact size). Allele tab

Example: A stutter distance of 3.25 to 4.75 specifies a = 0.75 bp
window around the possible —4 bp stutter peak.

The GeneMapper™ Software provides settings for minus and plus
stutter peaks.

Stutter filter (not a If a peak is within the stutter distance, and the stutter-to-allele peak | NA
setting) ratio is below the stutter ratio in the analysis method or Panel
Manager, the peak is filtered (not labeled in the electropherogram).

Note: To be analyzed, a peak must exceed the Peak Amplitude
Threshold in the analysis method Peak Detector tab.

Guidelines for troubleshooting and data interpretation CLA

* To investigate an SQ @ (sizing fails), perform the procedures in:
— Microsatellite Analysis Software— “Examine low-quality sizing results” on
page 51.

- GeneMapper" Software—“Examine low-quality sizing results” on page 74.

For more information, see the following sections in this chapter.

* To investigate an GQ @ (genotyping fails), perform the procedures in:

— Microsatellite Analysis Software —“Examine low-quality genotyping results”
on page 56.

- GeneMapper " Software—“Examine low-quality genotyping results” on
page 56.

For more information, see the following sections in this chapter.

* For information on the PQV symbols that are displayed in the samples or
genotypes table ( @) see:

— Microsatellite Analysis Software—“About PQVs (Process Quality Value
symbols )” on page 56.

- GeneMapper" Software—“About PQVs (Process Quality Value symbols )”
on page 82.

For more information, see the following sections in this chapter.

* To be detected and labeled, a stutter peak must exceed the Peak Amplitude
Threshold in the analysis method and the stutter ratio in the panel. The default
stutter ratio filter values that are provided in the panel were determined by
extensive studies. However, it is not unusual to observe stutter peaks that are
above the stutter ratio filter values. If you consistently observe a stutter peak for
a marker, you can create a filter to prevent the peak from being labeled (as
determined by your standard operating protocol).
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Guidelines for troubleshooting

and data interpretation CLA

Stutter peak amplitude is additive. Example: If an N+2 stutter peak from allele
peak A migrates at the same location as an N-2 stutter peak from allele peak B,
the stutter peak height is increased.

If you run multiple allelic ladders, the allele calls are averaged for all allelic
ladders in a project ( Microsatellite Analysis Software) or a folder (GeneMapper "
Software). You can re-analyze a sample using the allelic ladder that is in the
closest well position to the sample for possibly improved genotyping results. (To
do so, either remove all but the allelic ladder of interest from the project and re-
analyze, or create a new project with the sample and the allelic ladder.)

To determine if a sample peak is expected at a specific size in a marker, display
the electropherograms for the sample, size standard, and allelic ladder.

Before you conclude that a peak is a possible microvariant (after ruling out that it
is a stutter peak or artifact), confirm that the peak reproducibly migrates at the
observed bp (by running samples in duplicate or by repeating the electrophoresis
run).

If you observe unexpected stutter peaks across all profiles, repeat amplification
(ensure correct buffer pH, thermal cycling settings).
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Chapter 7 Troubleshooting
D3S1358 marker shoulder and stutter peak examples (N+1, N-4, and N+4)

&
~
=

%

D3S1358 marker shoulder and stutter peak examples (N+1, N-4,

and N+4)

Note: A stutter peak is filtered (not labeled) if it is 1) above the Peak Amplitude
Threshold in the analysis method Peak Detector tab; 2) within the Stutter Distance
range in the analysis method Allele tab; 3) above the stutter ratio (% of allele peak) in
the panel.

15 L 1é 17 1z
124 062581 125,96 132,96 136,95
11030 (5 220 1195 631

(D Allele peak 15

@ OL shoulder peak (+1 bp from allele peak 15)

@ Labeled plus stutter peak (+4 bp from allele peak 15). It is not filtered (and is therefore labeled)
because no plus stutter distance is set in the GeneMapper™ Software analysis method.

@ Labeled minus stutter peak (-4 bp from allele peak 18). It is not filtered (and is therefore
labeled) because the stutter ratio exceeds the stutter ratio set in the panel. [Stutter ratio for the
labeled 17 peak: 1195/9631=0.1240; Stutter ratio for the marker in the panel: 0.1227]

(® Allele peak 18

POP" polymer-specific artifact examples (N-1 and N+1 shoulder

peaks)

When using POP-7" Polymer or when using the SeqStudio™ Genetic Analyzer
Cartridge, N-1 and N+1 shoulder peaks are sometimes observed in the D7S820 and
AMEL markers.

Note: A stutter peak is filtered (not labeled) if it is 1) above the Peak Amplitude
Threshold in the analysis method Peak Detector tab; 2) within the Stutter Distance
range in the analysis method Allele tab; 3) above the stutter ratio (% of allele peak) in
the panel.
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POP™ polymer-specific artifact examples (N-1 and N+1 shoulder peaks)
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Figure 15 D7S820 marker

(D Allele peak 8

(2 Filtered minus stutter peak (~4 bp from allele peak 8)
@ OL shoulder peak (-1 bp from allele peak 8)

(@ OL shoulder peak (+1 bp from allele peak 8)

(®) Allele peak 12

@ Filtered minus stutter peak (-4 bp from allele peak 12)
(@) OL shoulder peak (-1 bp from allele peak 12)

OL shoulder peak (+1 bp from allele peak 12)

[AMEL I

M 103 105 107 109

i Y
101.85 107 .63
3171 21

Figure 16 N+1 shoulder peaks in SeqStudio” Genetic Analyzer data AMEL marker

(@) Allele peak
(2) N+1 shoulder peak
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D19S433: off-ladder alleles caused by dye pullup 01

D19S433: off-ladder alleles caused by dye pullup

If you observe an unexpected or off-ladder allele in the genotypes plot, note the
bp/height values for the peak, then evaluate the peak in the samples plot with all
dyes displayed. If the peak appears under an allele peak +0.5 bp, it may be a pull-up
peak.

In this example, the OL peak in the yellow dye (displayed in black in the software) is
at the same bp as the green dye peak, and is therefore is possibly a pull-up peak
instead of a true DNA peak.

[

13
117.92
10573

14 oL

121.80 12504 I I I
Of wvi ki

@ Genotypes plot

@ Samples plot with all dye channels displayed showing that the OL peak in the yellow dye may be caused by dye pull-up from

the green dye channel.

@ Sizing table (with samples plot open, select View » Tables » Sizing Table » )
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General troubleshooting

The Microsatellite Analysis Software uses colored circles
The GeneMapper™ Software uses colored shapes

@ as quality indicators.
@ as quality indicators.

The troubleshooting information in the following section refers to colored circles
@ . but the information applies to both the Microsatellite Analysis Software and the
GeneMapper™ Software.

Observation

Possible cause

Recommended action

SQ . (sizing fails)

The correct size standard is not
selected.

If SQis . for all samples, ensure that the
correct size standard is selected in the setup tab
( Microsatellite Analysis Software) or sample
table (GeneMapper™ Software). See:

¢ Microsatellite Analysis Software—page 52
and page 53

* GeneMapper" Software—page 77 and
“Modify size matches” on page 80

The peaks in the size standard
are not correctly labeled. See:

If SQis . for individual samples, examine the
size standard for the samples and update if
needed.

* Microsatellite Analysis Software—page 52
and page 53

* GeneMapper" Software—page 77 and
“Modify size matches” on page 80

Size standard was not added to
the samples.

Prepare samples again, make sure to add size
standard.

GQ . (genotyping fails)

The incorrect panel and bins are
specified.

Select the correct panel and bins. See:
* Microsatellite Analysis Software —page 49

*  GeneMapper" Software—page 72

No allelic ladder is specified for
the project.

Change at least one allelic ladder in the project
to Sample Type Allelic Ladder. See:

* Microsatellite Analysis Software—page 49

*  GeneMapper" Software—page 72

You manually created the
analysis method, panel, and bins
in the GeneMapper™ Software.

IMPORTANT! Use only panel
and bin TXT files that are
provided by Thermo Fisher
Scientific. If you use panel and
bin files that you create in the
GeneMapper™ Software, you
may see off-ladder alleles.

Change at least one allelic ladder in the project
to Sample Type Allelic Ladder. See:

* Microsatellite Analysis Software—page 49
*  GeneMapper™ Software—page 72

96
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General troubleshooting
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Observation

Possible cause

Recommended action

SQPQVis or @ and peaks
do not contain size labels

The fragment sizes of the size
standard definition do not match
the positions of the detected
peaks.

Examine the size standard. See:
* Microsatellite Analysis Software—page 52
*  GeneMapper™ Software—page 77

SQPQVis or @ and one
or more peaks are miscalled

Peak detection threshold
associated with the size
standard is set too high or low.

Adjust the analysis method so that the Peak
Amplitude Threshold associated with the size
standard is greater than the height of the
miscalled peak.

SQPQVis or @, peaks are
clear and distinguishable, but
have low signal strength

Peak detection threshold
associated with the size
standard is set too high or low.

Adjust the analysis method so that the Peak
Amplitude Threshold associated with the size
standard is greater than the height of the
miscalled peak.

Electrophoresis or pipetting error

Adjust the analysis method so that the Peak
Amplitude Threshold associated with the size
standard is greater than the height of the
miscalled peak.

SQ PQVis or . because
size standard peaks occur within
a primer peak

The smallest peaks of the size
standard can appear within the
primer range.

Create and analyze the data using a custom size
standard that does not include the undetectable
peak.

sQPQVis © or @, size
standard peaks are clear and
distinguishable, but consistently
have low signal strength

Incorrect concentration of size
standard in sample loading
reagent.

Increase the concentration of size standard
added to subsequent runs.

Incorrect injection settings.

Review the injection settings of the run module
for errors.

SQPQVis or @ and size
calling errors occur for different
samples on the same capillary
over multiple runs

Defective capillaries/arrays.

Troubleshoot the defective capillaries/arrays.

sQPQVis © or @, size
standard peaks are clear and
distinguishable, but consistently
have low signal strength, and
sizing failures occur in a regular
pattern (the same wells fail
repeatedly)

Electrophoresis or pipetting
error.

Reinject the sample. If needed, prepare fresh
sample.

Elevated stutter peaks or
spurious peaks are observed

DNA input is too high.

Prepare samples with lower DNA input, then re-
run.

Allelic dropout or imbalance in
samples and size standard

DNA input is too low.

Prepare samples with increased DNA input if
possible, then re-run.

Incorrect thermal cycling
parameters.

Use the thermal cycling parameters
recommended in Chapter 2, “Perform PCR:
CLA Identifiler™ Plus kit” or Chapter 3, “Perform
PCR: CLA Identifiler™ Direct kit”.
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Observation

Possible cause

Recommended action

Allelic dropout or imbalance in
samples and size standard
(continued)

Use of a thermal cycler that is
not listed in “Instrument and
software compatibility” on
page 15. Other thermal cyclers
may have different thermal
properties/ramp rates.

Use only thermal cyclers listed in “Instrument
and software compatibility” on page 15.

Confirm proper use of thermal cycler
accessories such as compression pad, tray and
retainers.

Allelic dropout or imbalance in
samples only

PCR inhibitors in samples.

Prepare samples with decreased DNA input to
reduce inhibitor concentration, then re-run.

Incorrect allele calls

Incorrect peak amplitude
thresholds in analysis settings.

Adjust the analysis method.

Spikes and other non-
reproducible, anomalous peaks

Use of expired reagents on the
instrument, or instrument
maintenance required.

Perform routine instrument maintenance.

Replace expired reagents.

98
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Materials required but not supplied

STRkitmaterials ......................
Sample preparation required materials
Thermal cycler required materials ........
Genetic analyzer required materials ... ...
Analysis software required materials . .. ..

Miscellaneous required materials . .......

Unless otherwise indicated, all materials are available through thermofisher.com.
"MLS" indicates that the material is available from fisherscientific.com or another

major laboratory supplier.

STR kit materials

Item Source
CLA Identifiler™ Plus PCR Amplification Kit A44660
CLA Identifiler™ Direct PCR Amplification Kit A44661
Sample preparation required materials
Table 1 Identifiler” Plus kit
Item Source
Low-TE buffer (10 mM Tris, 0.1 mM EDTA, pH 8.0) Teknova T0223

or see “Prepare low-TE buffer” on
page 18.

Hi-Di™ Formamide, 25-mL

4311320

CLA Identifiler™ Plus and Identifiler™ Direct PCR Amplification Kits User Guide
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Appendix A Materials required but not supplied
Thermal cycler required materials

Table 2 Identifiler” Direct kit

Item Source
NUCLEIC-CARD" matrix, 1 spot MLS!T]
NUCLEIC-CARD" COLOR matrix, 1 spot MLS
Uni-Core™ Punch, 1.2 mm MLS
' Major laboratory supplier
Thermal cycler required materials
ProFlex” PCR System

Item Source
ProFlex™ 96-well PCR System 4484075
ProFlex™ 2 x 96-well PCR System 4484076
ProFlex™ 3 x 32-Well PCR System 4484073
Veriti” Thermal Cycler

Item Source
Veriti™ 96-Well Thermal Cycler 4479071
(Optional) Tabletop centrifuge with 96-Well Plate Adapters MLS
GeneAmp" PCR System 9700

Item Source
GeneAmp™ PCR System 9700, 96-Well Silver N8050001
GeneAmp™ PCR System 9700, 96-Well Gold-Plated 4314878
Silver 96-Well Sample Block N8050251
Gold-Plated 96-Well Block 4314443
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Genetic analyzer required materials

Genetic analyzer required materials

SeqStudio™ Genetic Analyzer

Item Source

Available on apps.thermofisher.com
(Optional) SeqStudio” Plate Manager and App or for download at

thermofisher.com

(Optional) Handheld Barcode Scanner 4488442
SeqStudio™ Genetic Analyzer Cartridge v2 A41331
SeqStudio™ Genetic Analyzer Cathode Buffer Container A33401
Reservoir Septa (for cathode buffer) A35640
MicroAmp"™ Optical 96-Well Reaction Plate 4316813
MicroAmp™ Optical 96-Well Reaction Plate with Barcode 4326659
MicroAmp"™ Optical 8-Tube Strip, 0.2 mL 4316567
Septa for SeqStudio™ Genetic Analyzer, 96 well A36541
Septa for SeqStudio™ Genetic Analyzer, 8 strip A36543
MicroAmp™ 96-Well Tray/Retainer Set
403081
(Adapter for 8-Tube Strip)
Hi-Di"™ Formamide 4401457
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
3500/3500xL Series Genetic Analyzer
Iltem Source
3500/3500xL Data Collection Software v3.3 (Windows" 10) A40059, A40376
3500/3500xL Data Collection Software v3.1 (Windows"7) 4405186, 4405187
Anode buffer container (ABC) 4393927
Cathode buffer container (CBC) 4408256
POP-7" Polymer (960 samples) for 3500/3500xL Genetic Analyzers 4393714
POP-7" Polymer (384 samples) for 3500/3500xL Genetic Analyzers 4393708
POP-7" Polymer (96 samples) for 3500/3500xL Genetic Analyzers A26073
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
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Appendix A Materials required but not supplied
Genetic analyzer required materials

Iltem Source
Conditioning reagent 4393718
8-Capillary array, 36 cm for 3500 Genetic Analyzers 4404683
8-Capillary array, 50 cm for 3500 Genetic Analyzers 4404685
24-Capillary array, 36 cm for 3500xL Genetic Analyzers 4404687
24-Capillary array, 50 cm for 3500xL Genetic Analyzers 4404689
96-well retainer & base set (Standard) 3500/3500xL Genetic Analyzers 4410228
8-Tube retainer & base set (Standard) for 3500/3500xL Genetic Analyzers 4410231
8-Strip Septa for 3500/3500xL Genetic Analyzers 4410701
96-Well Septa for 3500/3500xL Genetic Analyzers 4412614
Septa Cathode Buffer Container, 3500 series 4410715

3730/3730xI Series Genetic Analyzer

Iltem Source
3730xL Data Collection Software v5 (Windows™10) 4475133
3730/3730xL Data Collection Software v4 (Windows"7) 4405186, 4405187
3730 DNA Analyzer 48-Capillary Array, 36-cm 4331247
3730 DNA Analyzer 48-Capillary Array, 50-cm 4331250
3730x/ DNA Analyzer 96-Capillary Array, 36-cm 4331244
3730x/ DNA Analyzer 96-Capillary Array, 50-cm 4331246
POP-7" Polymer 4363929
1x28 mL
POP-7" Polymer 4363935
10 x 28 mL
3730 Running Buffer (10X) 4335613
500 mL
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
Hi-Di"™ Formamide 4311320
Polymer Block Cleaning Kit 4335860
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Analysis software required materials

3130/3130xI Series Genetic Analyzer

Iltem Source
3130 Data Collection Software v4 4475105
3130x/ Data Collection Software-v4 4475126
96-Well Plate Septa 4315933
Reservoir Septa 4315932
3100/3130 x/ Genetic Analyzer Capillary Array, 16-capillary 36-cm 4315931
3100/3130 x/ Genetic Analyzer Capillary Array, 16-capillary 50-cm 4315930
3100/3130 Genetic Analyzer Capillary Array, 4-capillary 36-cm 4333464
3100/3130 Genetic Analyzer Capillary Array, 4-capillary 50-cm 4333466
POP-7" Polymer for 3130/3130x/ Genetic Analyzers 4363785, 4352759
Running Buffer, 10X 402824
DS-33 Matrix Standard Kit (Dye Set G5) 4345833
MicroAmp™ Optical 96-Well Reaction Plate N8010560

Analysis software required materials

GeneMapper™ Software

Item Source

GeneMapper" Software v6, Full Installation, (Windows™ 10/Windows™ 7
A38888

SP1)
GeneMapper ~ Software v6, Client Installation, (Windows = 10/Windows = 7 4475074
SP1)
GeneMapper™ Software v5, Full Installation, (Windows™ 7 SP1) A31128
GeneMapper" Software v5, Client Installation, (Windows™ 7 SP1) A38892
Microsatellite Analysis Software

Item Source
Microsatellite Analysis Software apps.thermofisher.com
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Miscellaneous required materials

Miscellaneous required materials

Plates and tubes

Iltem Source
MicroAmp™ 96-Well Tray N8010541
MicroAmp™ Reaction Tube with Cap, 0.2 mL N8010540
MicroAmp™ 8-Tube Strip, 0.2 mL N8010580
MicroAmp™ Optical 8-Cap Strips 4323032
MicroAmp™ 96-Well Tray/Retainer Set 403081
MicroAmp"™ 96-Well Base N8010531
MicroAmp™ Clear Adhesive Film 4306311
MicroAmp™ Optical Adhesive Film 4311971
MicroAmp™ Optical 96-Well Reaction Plate N8010560
Laboratory supplies

Iltem Source
Various procedures
Aerosol resistant pipette tips MLS!]
Microcentrifuge tubes MLS
Pipettors MLS
Tape, labeling MLS
Tube, 50-mL Falcon™ MLS
Tube decapper, autoclavable MLS
Deionized water, PCR grade MLS
Vortex MLS

' Major laboratory supplier
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Safety

WARNING! GENERAL SAFETY. Using this product in a manner not specified in the
user documentation may result in personal injury or damage to the instrument or
device. Ensure that anyone using this product has received instructions in general
safety practices for laboratories and the safety information provided in this
document.

. Before using an instrument or device, read and understand the safety information
provided in the user documentation provided by the manufacturer of the
instrument or device.

. Before handling chemicals, read and understand all applicable Safety Data Sheets
(SDSs) and use appropriate personal protective equipment (gloves, gowns, eye
protection, and so on). To obtain SDSs, see the “Documentation and Support”
section in this document.
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Chemical safety

Chemical safety

106

WARNING! GENERAL CHEMICAL HANDLING. To minimize hazards, ensure
laboratory personnel read and practice the general safety guidelines for chemical
usage, storage, and waste provided below. Consult the relevant SDS for specific
precautions and instructions:

. Read and understand the Safety Data Sheets (SDSs) provided by the chemical
manufacturer before you store, handle, or work with any chemicals or hazardous
materials. To obtain SDSs, see the "Documentation and Support" section in this
document.

. Minimize contact with chemicals. Wear appropriate personal protective equipment
when handling chemicals (for example, safety glasses, gloves, or protective
clothing).

. Minimize the inhalation of chemicals. Do not leave chemical containers open. Use
only with sufficient ventilation (for example, fume hood).

. Check regularly for chemical leaks or spills. If a leak or spill occurs, follow the
manufacturer cleanup procedures as recommended in the SDS.

. Handle chemical wastes in a fume hood.

. Ensure use of primary and secondary waste containers. (A primary waste container
holds the immediate waste. A secondary container contains spills or leaks from the
primary container. Both containers must be compatible with the waste material
and meet federal, state, and local requirements for container storage.)

. After emptying a waste container, seal it with the cap provided.

. Characterize (by analysis if needed) the waste generated by the particular
applications, reagents, and substrates used in your laboratory.

. Ensure that the waste is stored, transferred, transported, and disposed of
according to all local, state/provincial, and/or national regulations.

. IMPORTANT! Radioactive or biohazardous materials may require special handling,
and disposal limitations may apply.

AVERTISSEMENT ! PRECAUTIONS GENERALES EN CAS DE MANIPULATION
DE PRODUITS CHIMIQUES. Pour minimiser les risques, veiller a ce que le
personnel du laboratoire lise attentivement et mette en ceuvre les consignes de
sécurité générales relatives a I'utilisation et au stockage des produits chimiques et a
la gestion des déchets qui en découlent, décrites ci-dessous. Consulter également la
FDS appropriée pour connaitre les précautions et instructions particulieres a
respecter :

. Lire et comprendre les fiches de données de sécurité (FDS) fournies par le
fabricant avant de stocker, de manipuler ou d’utiliser les matériaux dangereux ou
les produits chimiques. Pour obtenir les FDS, se reporter a la section
« Documentation et support » du présent document.

. Limiter les contacts avec les produits chimiques. Porter des équipements de
protection appropriés lors de la manipulation des produits chimiques (par
exemple : lunettes de slreté, gants ou vétements de protection).
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Biological hazard safety

. Limiter I'inhalation des produits chimiques. Ne pas laisser les récipients de
produits chimiques ouverts. lls ne doivent étre utilisés qu’avec une ventilation
adéquate (par exemple, sorbonne).

. Veérifier régulierement I’'absence de fuite ou d’écoulement des produits chimiques.
En cas de fuite ou d’écoulement d’un produit, respecter les directives de
nettoyage du fabricant recommandées dans la FDS.

. Manipuler les déchets chimiques dans une sorbonne.

. Veiller a utiliser des récipients a déchets primaire et secondaire. (Le récipient
primaire contient les déchets immédiats, le récipient secondaire contient les fuites
et les écoulements du récipient primaire. Les deux récipients doivent étre
compatibles avec les matériaux mis au rebut et conformes aux exigences locales,
nationales et communautaires en matiére de confinement des récipients.)

. Une fois le récipient a déchets vidé, il doit étre refermé hermétiquement avec le
couvercle fourni.

. Caractériser (par une analyse si nécessaire) les déchets générés par les
applications, les réactifs et les substrats particuliers utilisés dans le laboratoire.

. Vérifier que les déchets sont convenablement stockés, transférés, transportés et
éliminés en respectant toutes les réglementations locales, nationales et/ou
communautaires en vigueur.

. IMPORTANT ! Les matériaux représentant un danger biologique ou radioactif
exigent parfois une manipulation spéciale, et des limitations peuvent s’appliquer a
leur élimination.

Biological hazard safety

‘ WARNING! BIOHAZARD. Biological samples such as tissues, body fluids,

infectious agents, and blood of humans and other animals have the potential to
transmit infectious diseases. Conduct all work in properly equipped facilities with the
appropriate safety equipment (for example, physical containment devices). Safety
equipment can also include items for personal protection, such as gloves, coats,
gowns, shoe covers, boots, respirators, face shields, safety glasses, or goggles.
Individuals should be trained according to applicable regulatory and company/
institution requirements before working with potentially biohazardous materials.
Follow all applicable local, state/provincial, and/or national regulations. The following
references provide general guidelines when handling biological samples in laboratory
environment.

. U.S. Department of Health and Human Services, Biosafety in Microbiological and
Biomedical Laboratories (BMBL), 5th Edition, HHS Publication No. (CDC) 21-1112,
Revised December 2009; found at:
https://www.cdc.gov/labs/pdf/
CDC-BiosafetymicrobiologicalBiomedicalLaboratories-2009-P.pdf

. World Health Organization, Laboratory Biosafety Manual, 3rd Edition,
WHO/CDS/CSR/LY0/2004.11; found at:

www.who.int/csr/resources/publications/biosafety/Biosafety7.pdf
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Documentation and support

Related documentation

Document Publication number
Thermal cyclers
ProFlex™ PCR System User Guide MAN0007697
Veriti" Thermal Cycler User Guide 4375799
GeneAmp" PCR System 9700 Base Module User 4303481

Manual

SeqStudio™ Genetic Analyzer

SeqStudio™ Genetic Analyzer Instrument and Software MANO0018646
User Guide v1.2

3500 Series Genetic Analyzer

3500/3500xL Genetic Analyzer with 3500 Series Data 100079380
Collection Software v3.3 User Guide

3500/3500xL Genetic Analyzer with 3500 Series Data 100031809
Collection Software 3.1 User Guide

3730/3730xI DNA Analyzer

3730xI DNA Analyzer with 3730xI Data Collection 100077621
Software 5 User Guide

Applied Biosystems™ 3730/3730xI DNA Analyzers 4478016
Getting Started Guide

Analysis software

Microsatellite Analysis Software User Guide MANO0017825
GeneMapper™ Software 6 Installation and Administration 100079198
User Guide

GeneMapper™ Software 5 Installation and Administration 4476603
User Guide

Note: Version 4.1 user documentation applies to Version 5 and Version 6 software. No features have changed in
the newer versions of software.

Note: Newer versions of the documents may be available on www.thermofisher.com.
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Documentation and support
Application notes

Document Publication number

GeneMapper™ Software v4.1 Installation Options User 4403675
Bulletin

GeneMapper™ Software v4.1 Autoanalysis User Bulletin 4403670
GeneMapper™ Software v4.1 Reference and 4403673
Troubleshooting Guide

GeneMapper" Software v4.1 Quick Reference Guide 4403615
GeneMapper™ Software v4.1 Microsatellite Analysis 4403672
Getting Started Guide

Application notes

Document url

Application note: Authenticating human cell lines using Download from www.thermofisher.com/CLA.
the Identifiler kits and capillary electrophoresis platforms

Application note: Matching identities of iPSCs and
donors using CLA Identifiler STR profiling kits

Application note: Matching identities of iPSCs and
donors using Identifiler STR profiling kits

Application note: Confidently identify human samples
using the CLA Identifiler and CLA GlobalFiler STR kits
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+A nucleotide addition 90

3' A peaks in electropherogram, definition 90
3130/3130xl instrument
capillary-to-plate mapping 30
catalog numbers 103
electrophoresis set up 30
3500/3500xL instrument
capillary-to-plate mapping 30
catalog numbers 101
electrophoresis set up 29
3730/3730xI instrument
capillary-to-plate mapping 30
catalog numbers 102
electrophoresis set up 30
9947A. See DNA control

A
allelic ladder
about 9
profile 12
requirements for analysis, GeneMapper Software

63
requirements for analysis, Microsatellite Analysis
Software 36
requirements for electrophoresis 28
volume per reaction 33
AMEL marker, N+1 shoulder peak examples in Seg-
Studio data 93
amplicication reactions, prepare 25
AN PQV 82
analysis method, GeneMapper Software, import 70
analysis settings
GeneMapper Software 81
Microsatellite Analysis Software 55
analysis settings, Microsatellite Analysis Software,
import 42
analysis software, for use with kit 15
application notes 109
artifact peaks in electropherogram
application note 109
definition 90
N-1 and N+1 examples in SeqStudio data 93

Index

ATCC database 61, 87

B

BIN PQV 58
bins, import, GeneMapper Software 67
biohazard safety 107

C

capillary-to-plate mapping 30
cell density required 17
cell line preparation 17,22
contaminating cells in a culture, identification 15
control DNA
9947A 9
about 9
profile 10

D

D19S433 marker, pull-up peak examples 95
D19S433 marker off-ladder allele examples 95
D21S11 marker, pull-up peak examples 95
D3S1358 marker, stutter peak examples 93
D7S820 marker, N+1 shoulder peak examples in
SeqgStudio data 93
data collection software
3130/3130xl instruments 30
3500/3500xL instruments 29
3730/3730xL instruments 30
SeqgStudio instrument 29
view settings, GeneMapper Software 74
view settings, Microsatellite Analysis Software
51
DNA control profile 10
DNA input amount 18
documentation, related 108
download new settings
GeneMapper Software 66
Microsatellite Analysis Software 41
dyes used in kit 8
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E

electrophoresis
3130/3130xl instruments 30
3500/3500xL instruments 29
3730/3730xL instruments 30
prepare samples 33
SeqgStudio instrument 29

extra peaks in electropherogram 89

extraction, DNA 17, 22

G

GeneMapper Software

import analysis method 70

import panel and bins 67

import size standard 69

import table and plot settings 71
GeneScan 600 LIZ size standard

about 9

profile 11
genetic analyzers, for use with kit 15
genotypes, compare to ATCC database 61, 87
genotypes table

export, GeneMapper Software 87

export, Microsatellite Analysis Software 60
ghost peaks in electropherogram, application note

109

GQ (genotype quality)

GeneMapper Software 82

Microsatellite Analysis Software 56

import files
GeneMapper Software 64
Microsatellite Analysis Software 40
instrument compatibility 15
iPSCs, application note 109

K
kit
description 7
dyes 8
loci 8
storage conditions 13, 14

L

LIZ size standard, volume per reaction 33
loci amplified by the kit 8

Index

M

materials not supplied 99
MSA settings template, import, Microsatellite Analy-
sis Software 42

N

N-1 shoulder peak examples 93
N-4 stutter peak examples, D3S1358 marker 93
N+1 shoulder peak examples

D3S1358 marker 93

SeqStudio instrument 29, 30, 93, 101
N+4 stutter peak examples, D3S1358 marker 93
NUCLEIC-CARD

prepare with sample 23

store 23

0)

off-ladder allele example 58

off-ladder allele examples, D19S433 and D21S11
markers 95

OL peak label 58, 95

P

panel
check version, Microsatellite Analysis Software
41
import , Microsatellite Analysis Software 44
import, Microsatellite Analysis Software 42
panel and bins
check version, GeneMapper Software 65
import, GeneMapper Software 67
panel manager, repeat unit and stutter ratio settings
90
PCR, Identifiler Direct kit
conditions 26
perform 26
PCR, Identifiler Plus kit
conditions 21
number of cycles to use 20
perform 21
prepare amplification reactions 19
PHR PQV 58, 82
plot settings
import, GeneMapper Software 71
Microsatellite Analysis Software 48
polymer artifacts 93
PQV (process quality value)
GeneMapper Software 82
Microsatellite Analysis Software 56
product description 7
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Index

pull-up peaks in electropherogram
D19S433 marker 95
D21S11 marker 95
purification, DNA 17, 22

Q

quantification, DNA 17, 22

R

related documentation 108
repeat units for a marker 90
required materials 99
run module
3130/3130xI 30
3500/3500xL 29
3730/3730xI 30
SeqgStudio 29

S

safety, biohazard 107

SeqgStudio instrument
capillary-to-plate mapping 30
catalog numbers 101
electrophoresis set up 29
required dye calibration 29

shoulder peaks in electropherogram
AMEL marker examples 93
D7S820 marker examples 93

size standard
import, GeneMapper Software 69

112

import, Microsatellite Analysis Software 42, 46

size standard profile 11
software compatibility 15
SQ (sizing quality
GeneMapper Software 74
Microsatellite Analysis Software 51
storage conditions, kit 13, 14
STR repeat units for a marker 90
stutter
distance 90
filter 90
ratio 90

stutter peak in electropherogram, expected location

90
stutter peaks in electropherogram
application note 109
D3S1358 marker 93
definition 89
stutter peak ratio 90
stutters peak in electropherogram, filter 90

T

table settings
import, GeneMapper Software 71
Microsatellite Analysis Software 48
technical notes 109
template. See MSA settings template
thermal cyclers
for use with kit 15
programming, Identifiler Direct kit 26
programming, Identifiler Plus kit 21
troubleshooting 89
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